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Preface  

This series of manuals is about the teach pendant Hspad-201. The manual introduces its 

characteristics, system composition, system commands and usage of each part, operation steps, user 

programming methods and examples, etc. It is a basic manual for users to quickly learn and use the 

teach pendant. The update and upgrade of this manual is authorized and organized by Foshan 

Huashu Robotics Co., Ltd. which is a subsidiary of Wuhan Huazhong Numerical Control Co., Ltd. 

(Stock code:300161). Without the authorization or written permission of the company, any other 

unit or individual has no right to modify or adjust the contents of this manual, and we are not 

responsible for the losses caused thereby. 

This teach pendant (Hspad) is suitable for HSR robots. In the programming manual of the teach 

pendant, we will try our best to describe various events related to the operation of the teach pendant. 

Due to space limitations and product development confidentiality, it is impossible to give a detailed 

description of all events that are not necessary or cannot be done in the teach pendant. Therefore, 

events not specifically described in this specification can be regarded as "impossible" or "not 

allowed" events. 

We checked whether the printed content is consistent with the described hardware and software 

content. Although inconsistencies cannot be completely ruled out, we will regularly proofread the 

printed content and make necessary changes in subsequent editions. Inconsistencies might not be 

completely ruled out, so we will regularly proofread the printed content and make necessary changes 

in subsequent editions.  

The copyright of this manual belongs to Foshan Huashu Robotic Co., Ltd., the subsidiary of 

Wuhan Huazhong Numerical Control Co., Ltd. Any other unit or individual publishing or copying 

is illegal, and we will pursue its legal responsibility. 
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1 Introduction 

HSR control system Type Ⅲ is a new control system developed by the robotics subsidiary of Wuhan 

Huazhong Numerical Control Co., Ltd. 

1.1 Target users 

This manual is mainly for users who use HSR industrial robots. Users are required to have basic 

knowledge of industrial robots 

1.2 Icon description 

 

Reminder message. Further instructions for operation 

 

Warning message, warning of possible losses 

 

Error message, indicating the error that occurred 

1.3 Terminology 

TCP：Tool Center Point 

2 Introduction to Type Ⅲ Control System 

The HSR industrial robot type Ⅲ control system is a set of control system independently developed 

by HSR company. It has the characteristics of high speed and high precision. Its programming 

language is simple and easy to understand. Fast programming and real-time adjustment can be 

achieved through the type III teach pendant to meet most industrial needs. 

2.1 System composition 

The composition of HSR industrial robot system mainly includes the following four parts: 

 Robotic arm 
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 Connect cables 

 Electronic control system 

 HSpad teach pendant 

 

Figure 2-1 Connection diagram of HSpad and HSR robot 

2.2 Software of teach pendant Type Ⅲ  

The software of teach pendant Type Ⅲ control system mainly includes 

 Software of the teach pendant: HSC3-HSpad 

3 Safety 

3.1 Attentions 

1. Please operate the robot where you can ensure your safety 

2. Please make sure that the state of the robot is stable and the base is stable. 

3. Please operate the robot in accordance with compliant operations, and illegal operations are 

strictly prohibited. 

4. Make sure that the surrounding environment will not affect the robot before use. 

5. The company is not responsible for the safety of the robot. 

6. Safety equipment must be used when using industrial robots, and safety provisions must be 
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observed. 

7. The robots can move large distances at high speeds. 

8. Never turn your back to the robot. 

3.2 Occasions the robots cannot be used 

1. Burning environment. 

2. A potentially explosive environment. 

3. An environment with radio interference. 

4. In water or other liquids. 

5. Used to carry people or other animals. 

6. Unattainable. 

7. Other occasions cannot be used. 

3.3 Safe operating procedures 

3.3.1 Teach and control the robot by manual 

1. Try to use a lower speed override when operating the robot point-to-point movement. 

2. Before pressing the move button on the software, consider the robot's movement trend in 

advance. 

3. It is necessary to consider in advance that the robot's movement route is not disturbed. 

4. The area around the robot must be clean and free of oil, water and impurities. 

3.3.2 Production movement 

1. Before starting up and running, you must know all the tasks that the robot will perform 

according to the programmed program. 

2. It is necessary to know the position and status of all switches, sensors and control signals 

that will affect the movement of the robot. 

3. The location of the emergency stop buttons on the robot controller and peripheral control 

equipment must be known, so that these buttons can be used in an emergency in time. 

4. Keep a safe distance from the robot at all times. 

 

If the robot is powered off, it needs to wait for the discharge to complete 

before being powered on again. 
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4 Hspad Teach Pendant Type Ⅲ 

4.1 Front 

 

Pic 4-1 Hspad Front 

  Label Description 

1 

Used to call up the key switch connected to the controller. Only 

after inserting the key, the state can be changed. 

The operation mode (manual/automatic/external) can be 

switched by connecting the controller. 

2 
Emergency stop button (emergency stop). Used to stop the robot 

in dangerous situations. 

3 Jog Key. Used to manually move the robot. 

4 
Key for setting the program adjustment amount. Automatic and 

external operation magnification adjustment. 

5 
Key for setting manual adjustment amount. Manual operation of 

magnification adjustment. 

6 
Menu button. You can switch between the menu and file 

navigator. 

7 Pause button. It is used to pause the operation when the program 
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is running. 

8 Stop button. Used to stop and uninstall the running program. 

9 Back button. Used to roll back program operation. 

10 
Start button. When the program is successfully loaded, click this 

button to start the program. 

11 Spare button. 

4.2 Back 

 

Pic 4-2 Hspad Back 

 

Label  Description  

1 

Three-stage safety switch. 

The safety switch has 3 positions: 

① Not pressed 

② Middle position 

③ Fully press 

In the operation mode manual T1 or manual T2, the confirmation 

switch must be kept in the middle position to make the robot 

move, and the other positions are closed and enabled. 

In the automatic operation mode, the safety switch does not work. 

2 The place to paste the model label 

3 Debug interface 
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4 
U disk USB socket. 

The USB interface is used for archive/restore operations. 

 

4.3 HSpad Operation interface 

 

Pic 4-3 Operation interface 

 

Label Description 

1 Information prompt counter. 
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The information prompt counter shows how many pieces of each 

information type are waiting to be processed. Touch the information 

prompt counter to enlarge the display. 

2 

Status Bar. 

Display the current model, load level, loaded program, enable state, 

program state, operation mode, magnification, program operation 

mode, tool workpiece number, incremental mode. 

3 

Information window. 

According to the default setting, only the last information prompt 

will be displayed. Touch the information window to display the 

information list. All pending information will be displayed in the list. 

The information that can be confirmed can be confirmed with the 

【Confirm】 key. 

【Information Confirmation】key to confirm all information except 

the error information. 

【Alarm Confirmation】key to confirm all error information. 

"?" button can display the detailed information of the current 

information. 

4 

Coordinate system status. 

Touch this icon to display all coordinate systems and switch between 

selections. 

5 

Jog operation instructions. 

If an axis-related operation is selected, the axis number (A1, A2, 

E1, E2, etc.) will be displayed here. If Cartesian operation is 

selected, the direction of the coordinate system (X, Y, Z, A, B, C) 

will be displayed here. 

Touch the icon to display the motion system group selection 

window. After selecting a group, it will be displayed as the 

corresponding name in the corresponding group. 

6 Automatic magnification adjustment icon. 

7 Manual override icon. 

8 
Operate the menu bar. 

Used for related operations of program files. 

9 

Network status. 

Red is network connection error, check the network line problem. 

Yellow means that the network connection is successful, but the 
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initialization of the controller is not completed, and the robot cannot 

be controlled. 

Green means that the network has been initialized successfully and 

HSpad is normally connected to the controller to control the 

movement of the robot. 

10 

Clock  

The clock can display the system time. Click the clock icon to 

display the system time and current system running time in digital 

form. 

11 

One key to zero 

Click this icon to realize one-key return to zero position (that is, 

realize the initial position of the set program operation) 

4.3.1 Status Bar 

The status bar displays the status of the industrial robot settings. In most cases, a window will 

open by clicking the icon, and you can change the settings in the opened window. 

 

Pic 4-4 Status bar 

Label  Description 

1 
Menu  

The function is the same as that of the menu button. 

2 
Robot name. 

Display the current robot model and load level. 

3 

The name of the loaded program. 

After the program is loaded, the path and name of the currently loaded 

program will be displayed 

4 

Enable state. 

Green and display "on", which means that the current enable is on. 

Red and "Off" is displayed, indicating that the current enable is off. 

Click to open the enable setting window. In automatic mode, you can only set 

the enable switch state by clicking the interface on/off. The pressed state of the 

safety switch can be displayed in the window. 

In manual mode, it can only be turned on or off by the safety switch 

5 
The running status of the program. 

Display the running status of the running program. 



 

 17 

6 

Mode status display. 

The mode can be set by the key switch, and the mode can be set to manual 

mode, automatic mode, and external mode. 

7 

Display magnification adjustment 

When the mode is switched, the override value of the current mode will be 

displayed. 

Touch to open the setting window, you can use the plus/minus (+/-) key to add 

and subtract settings in 1% units, or you can drag the scroll bar to the left and 

right. 

8 

The status of the program running mode. 

In automatic operation mode, it can only be continuous operation. In manual 

T1 and manual T2 modes, it can be set to single-step or continuous operation. 

Touch to open the setting window. In manual T1 and manual T2 modes, you 

can click the continuous/single step button to switch the operating mode. 

9 

Activate the base coordinate/tool display. 

Touch to open the window, click on the tool and base coordinates to select the 

corresponding tool and workpiece to set, the available tool and workpiece 

numbers are 0~15. 

10 

Incremental mode display. 

Touch in manual T1 or manual T2 mode to open the window, click the 

corresponding option to set the incremental mode. 

Persistence: continuous exercise 

Non-continuous: Move according to the set incremental distance (joint ° or 

space mm inch, transform according to the current coordinate system) 

        

4.3.2 Main menu 

Operation steps Click the "main menu icon" or button to open the window main menu. 

Click the "Main Menu Icon" or button again to close the main menu. 

Description  Window properties of the main menu: 

 The main menu is displayed in the left column. 

 Clicking on a menu item will display its subordinate menu (for example: 

configuration). 

 Click to open the lower-level menu when there are many layers, you may 

not see the main menu bar, but only the menu. At this time, the latest three-

level menu display will be displayed. 

 The “Home icon” key on the upper left closes all opened lower-level 

menus and only displays the main menu. 

 In the [lower area], the last selected menu item (up to 6) will be displayed, 

which is equivalent to a shortcut menu. In this way, these menu items can 

be directly selected again without having to close the opened lower-level 

menu first. 

 The red cross (“X”) on the left closes the window. 
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Pic 4-5 Main menu interface 

5 Settings page 

5.1 Communication connection 

Description    Establish a communication connection with the controller. 

Steps: 

1. Select "User Group" in the menu "Configuration-Teach Pendant Configuration", log in 

to the "super" user (switch to super user and above authority) 

2. In the menu bar "Configuration-Controller Configuration", select "Robot 

Communication Configuration" in the submenu 

3. "Save" operation after entering the IP and port corresponding to the controller 

4. Re-enlightenment device (click "System-Re-enlightenment device" in the menu bar or 

slide to close the app manually and then open the "HSC3-HSpad" app) 
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Pic 5-1 Robot communication configuration 

5.2 Authority management 

Description In version 1.6, there are 4 user groups, namely Normal, Super, Debug, and Final. 

The specific user permissions are as follows. (Note: Blank means that there is 

no permission to open the interface. Viewing means that you can only enter the 

page but not use the function. "√" means edit/use). In the HSpad system 

software, different users have different permissions.  

There are the following user groups: 

 Normal： 

Operator user group, this user group is the default user group. 

 Super： 

Super authority user group, this user group has more system function usage 

rights than the default ordinary users. This user is protected by a password. 

 Debug： 

Debugger user group, this user group has the right to use most of the 

system functions of the HSpad system. This user is protected by a 

password. 

 Final： 

The final authority user group, the user has all the right to use the Hspad 

system 
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[Note]  The default password is "hspad".  

The default user group will be selected during a new startup. 

First level 

menu 

Second level 

menu 

Third level 

menu 

User group 

Normal Super Debug Final 

File 

management 

Backup and 

restore 

settings 

—— 

You can 

only choose 

to set as the 

U disk root 

directory/def

ault path, not 

edit the 

custom path 

√ √ √ 

Lock 

password 

setting 

—— 

 

 √ √ 

Get register 

file 
—— View √ √ √ 

Log file 

management 
—— View √ √ √ 

File 

operations 

New ——  √ √ √ 

Load  —— √ √ √ √ 

Open  —— √ √ √ √ 

Save  ——  √ √ √ 

Delete ——  √ √ √ 

Backup ——  √ √ √ 

Recover ——  √ √ √ 

Multiple 

choice 
—— 

 
√ √ √ 

Rename ——  √ √ √ 

Lock ——   √ √ 

Turn on/off 

instructions 
—— √ √ √ √ 

On/off status —— √ √ √ √ 

Unseeded —— √ √ √ √ 

Optimization —— √ √ √ √ 
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Configuratio

n 

Teach 

pendent 

configuratio

n 

The user group √ √ √ √ 

Alternate button 

configuration 
View √ √ √ 

Process package 

management 
View √ √ √ 

Controller 

configuratio

n 

Robot 

communication 

configuration 

View √ √ √ 

Axis group 

configuration 
View View View √ 

Robot 

parameters 
View View View √ 

Running 

configuration 
View View √ √ 

Encoding/decod

ing 

configuration 

View View √ √ 

Zone 

configuration 
View  √ √ 

Time-out 

settings 
√ √ √ √ 

Authorized View √ √ √ 

Display  

The 

input/output 

Digital 

input/output 
View √ √ √ 

Analog 

input/output 
√ √ √ √ 

The actual 

location 
—— √ √ √ √ 

The list of 

variables 
—— View √ √ √ 

Diagnosis Run log 
Display  √ √ √ 

Configuration   √ √ 

Put into 

service 

Measuremen

t 

User tool 

calibration 
View √ √ √ 

The user work View √ √ √ 
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piece is marked 

Adjustment Calibration View View √ √ 

Software 

limit switch 
—— View View √ √ 

Help Information ——   √ √ 

System 

System 

language 

settings 

——   √ √ 

Restart teach 

pendant 
——   √ √ 

Clean up the 

system 
——   √ √ 

Shut down 

the system 
——   √ √ 

Restart the 

system 
——   √ √ 

System 

upgrade 
—— View View √ √ 

Import and 

export user 

PLC 

—— √ √ √ √ 

Import and 

export 

calibration 

parameters 

—— √ √ √ √ 

 

 

 

Interface 

buttons 

Start/pause 

button 
—— √ √ √ √ 

Mode 

switching 
——  √ √ √ 

Tool 

workpiece 

switching 

——  √ √ √ 

The program 

is step-by-

step/continu

——  √ √ √ 
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ous 

Manual 

continuous/s

tep 

——  √ √ √ 

Trim ——  √ √ √ 

Manual 

coordinate 

system 

——  √ √ √ 

The fallback 

button 
—— √ √ √ √ 

Process pack —— ——  √ √ √ 

The procedure   

1. Select "Configuration→Teach Pendant Configuration→User Group" in the main menu. 

The current user group will be displayed. 

2. To switch to the default user group, click Criterion. ( If you are already in the default 

user group, you cannot use the standard.）If you want to switch to another user group, 

select the user group you want. Press Sign in. 

3. Super users, Debug users, and Final users need to log in after entering a password, enter 

a password, and log in to confirm. 

4. Change the password: If you need to modify a user's password, select the user and press 

"Password" Button. 

5. After entering the original password and the new password in the password 

modification interface, click OK to modify the password. 
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Pic 5-2 The user login interface 

5.3 Alternate keys 

 

 

 

 

Description The teach pendant provides 4 auxiliary buttons on the left, which are used for 

user-defined button operations and can be configured to output commands after the buttons are 

pressed.  

There are 3 configuration types, IO type, process package, no configuration 

IO type: Shortcut keys for operating and outputting IO values (after pressing, the IO value 

will be reversed and output according to the current state) 

Process package: shortcut key to open the process package interface 

No configuration: turn off the backup button function 

Steps: 

1. Under Super authority, select Configuration→Teach Pendant Configuration→Alternate 

Button Configuration from the main menu to enter the alternate button configuration 

interface. 

2. Select the serial number and click the "Edit" button. 

3. Click to select the Function Type pull-down box option (e.g. select IO type). 

4. Enter the IO index number in the "DO Index" input box. 

5. The pull-down box option is selected as ON/OFF; 

 

The secondary keys can only be used in manual T1, T2 and automatic 

modes, not in external mode, and the setting permissions are Super and 

above. 
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6. Click the "OK" button to complete the configuration 

 

Pic 5-3 Alternate button configuration 

 

 

 

 

 

5.4 Axis group configuration 

 

 

 

 

 

 

 

  

Description The axis group configuration uses switching with models and load settings 

Steps: 

 

IO type: Press the corresponding configuration auxiliary button to set 

the IO value to ON or OFF. 

Process package: If a process package is installed in the teaching 

software, press the corresponding configuration auxiliary button to 

quickly open the process package interface (shortcut key to open the 

process package) 

 

Non-debuggers should not set the configuration of the axis group at will. 

Make sure that the model matches when configuring. After the setting is 

completed, check whether the zero point and limit are correct. The setting 

authority is Final. (Re-switching the model will lose the zero point, limit 

and other parameters, do not operate at will, you need to back up the system 

parameters first) 

Load classification: light load, medium load, heavy load 
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1. Under Final authority, select menu bar→ Configuration → Controller configuration → Axis 

group config to enter the axis group configuration interface. 

2. Click the "modify" button. 

3. Select the "Type" drop-down box option to select the robot model. 

4. Click the "Confirm" button. (Note: When switching models, the load will also switch at the 

same time, and the load will be switched by pressing the load option below) 

5. Click the "Edit" button. (The load can be switched to the robot separately, and the robot 

speed is different for different loads) 

6. Select the "Load" drop-down box option and select the load level; 

7. Click the "OK" button 

8. Complete the setting after restarting the system. 

 

Pic 5-4 Axis group configuration 

 

 

 

 

 

Note: When changing the load level, there is no need to switch the model 

again, just operate steps 1, 6~8. 

The function of setting the number of additional axes is reserved. 
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Description   Axis Group Information - The number of additional axes is configured to open 

the external axis 

Steps: 

1. Under Final authority, select menu bar→configuration→controller configuration→axis 

group configuration to enter the axis group configuration interface. 

2. Click the "Edit" button for the number of additional axes. 

3. Click the "additional axis number" input box and enter the number of additional axis. 

4. Click the "OK" button to complete the addition of additional axes. 

 

Pic 5-4-2 Axis group configuration 

Description   To switch to an external axis, you can use the axis number icon on the right to 

switch from internal axis to external axis. J1~J6 will become E1~E3. After switching, when the 

external axis is inching, the external axis can be related movement. 

Steps:  

1. The axis icon on the right, click the "Robot axis" drop-down box option 

2. Click to select the icon option "J1~J6" on the right. 

3. Click the drop-down box option, and click to select the "additional axis" option to 

switch to the additional axis to complete. (+-External axis jog is possible) 

5.5 Robot parameters 

Description    The robot parameters are used to view the details of the system parameters 

Steps： 

1. Select "Menu Bar → Configuration → Controller Configuration → Robot Parameters" 

to enter the robot parameter interface. 

2. Click the option drop-down box to display the details of the selected axis parameter. 
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Pic 5-5 Robot Parameters 

5.6 Encoding/decoding configuration 

Description   

The encoding function is to map the R register to the output of IO, and set the IO 

sequence according to the value of R. This process is binary encoding. The value of R is 

used to encode the corresponding IO sequence value, such as DO[1]-DO[4] and R[1] is 

associated, where R[1]=3 (binary 0011b), then DO[1]=1, DO[2]=1, and the remaining DO 

are all 0; the decoding function is to map the input of IO to R Register, external input 

corresponding signal, the controller will decode this signal to R register, for example 

DI[1]-DI[4] is mapped to R[2], external input DI[2]=1, then the corresponding R[ 2] = 2 

(binary 0010b). 

 

Steps   

1. Select the configuration→controller configuration→encoding/decoding 

configuration button in the main menu. 

2. Click to select Encoding configuration or Decoding configuration 

3. Click the "Add" button to enter the setting interface 

4. After the setting is completed, click the "OK" button to complete the setting 
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Pic 5-6 Encoding/decoding configuration 

 

 

Pic 5-6-2 Encoding/decoding changes the configuration 

 

5.7 Zero-point calibration 

Description  

The axis zero point calibration must be performed before the robot runs.  

The robot can only perform Cartesian movement after the zero point calibration and move the 

robot to a safe position. The mechanical position of the robot and the position of the encoder will 

be coordinated during the zero point calibration process. For this, the robot must be placed in a 

defined mechanical position, that is, the zero point calibration position. Then, the encoder return 

value of each axis is stored. The calibration positions of all robots are similar, but not exactly the 

 

Example: Code R[0]=42, DO[0~6] is associated, decimal 42 to binary is 

01010100, the corresponding value of DO[0~6] is also 010101, if output 

above DO[6] is associated Signals, such as DO[7~10] are all 0 

 

Decoding is the opposite. Convert the associated binary DI signal to 

decimal to get a value to the specified R register. For example: associate 

DI[0~6]=010101, bind R[1], after decoding, R[1] =42 
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same. The exact position will vary between different robots of the same robot model. 

The calibration function is updated to two types: internal and external axis calibration and absolute 

zero point saving. The difference between the two calibration methods is that after calibrating the 

zero point through internal and external axis calibration, when debugging, a non-zero point position 

is accidentally calibrated as the zero point (the zero point position is the position calibrated after the 

compensation amount is calculated by the plug and professional equipment), resulting in Need to 

re-calibrate the zero point; while saving the zero point through the absolute zero point, there is no 

need to re-calibrate the zero point, just click to restore the zero point. 

 

The robot must be calibrated before it can be put into operation, otherwise it will not 

function properly 

The robot must be calibrated in the following situations 

Situation  Note 

When the robot is put into operation Must be calibrated or it will not function properly 

After robot collides, the encoder value is lost Must be calibrated or it will not function properly 

When replacing the motor or encoder Must be calibrated or it will not function properly 

【Note】Zero-point calibration operations require Final user rights 

Internal axis calibration operation steps 

1. Click "Menu → Put into Operation → Adjustment → Calibration". 

2. Move the robot to the mechanical origin. 

3. After each axis moves to the mechanical origin, click each option in the list, and the 

input box will pop up, enter the correct data and click OK. 

4. After the data of each axis is input, click to save the calibration data, and save the data, 

which will take effect immediately. Whether the saving is successful can be verified by 

the current actual position data. 

External axis calibration operation steps 

1. Click "Menu → Put into Operation → Adjustment → Calibration". 

2. Move the external axis of the robot to the mechanical origin. 

3. Click the [Add Axis] button below. 

4. After the external axis moves to the mechanical origin, click each option in the list, and 

the input box will pop up, enter the correct data and click OK. 

5. After the data input of each axis is completed, click the [Save] button to save the data 

and take effect immediately. Whether the saving is successful can be verified by the 

current position data. 

 

If it shows that the calibration is unsuccessful, please check whether the network 

connection is successful; 

It can also support single-axis calibration (after calibration, the current actual 

position will become the set calibration value, usually a fixed position fixed 

calibration value) 



 

 31 

Absolute zero save operation steps 

1. Click "Menu → Put into Operation → Adjustment → Calibration". 

2. Move the robot to the mechanical origin. 

3. After each axis moves to the mechanical origin, click each option in the list, and the 

input box will pop up, enter the correct data and click OK. 

4. After the data input of each axis is completed, click the [Calibration] button to save the 

data and take effect immediately. Whether the saving is successful can be verified by the 

current position data and the encoder value data. 

Steps to restore zero save 

1. Click "Menu → Put into service → Adjustment → Calibration" 

2. Click each option in the list, the input box will pop up, enter the correct data (the same 

data as the calibration time) and click OK. 

3. After the data input of each axis is completed, click the [Restore] button to take effect 

immediately, and whether the restoration is successful can be checked by moving back to 

zero. 

 

 Figure 5-7 Zero point calibration  

 

 

Note: 1. The position of the mechanical zero point of different models is not exactly 

the same, and the calibration value is not the same. You can consult the relevant 

technical personnel, and the calibration value is also different at the non-zero position. 

2. After the zero calibration is completed, the system needs to be restarted to prevent 

the zero loss caused by the system upgrade without restarting after calibration. 
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5.8 Soft limit 

Description By setting the software limit switch, the axis range of all manipulators and 

positioning axes can be restricted. 

The software limit switch is used for robot protection, after setting, it can ensure 

that the robot runs within the setting range. 

The software limit switch is set when the industrial robot is running. According 

to the on-site environment, set the corresponding limit for each axis in turn, and the 

unit of axis data is the unit of radians. 

Note: When setting limit information, the value of the negative limit must be 

less than the value of the positive limit. 

 

When setting the robot into operation, the limit switch must be enabled and the 

corresponding axis data must be set, otherwise it may cause loss. The limit is based 

on the range of motion derived from the calibrated zero point of the robot. The 

calibrated zero point is a precondition. 

【Note】Final user rights are required to set the limit 

Steps 

1. Click the menu option, and then click "put into service→software limit switch" 

2. Select an axis, edit the limit data in the table, and click the limit enable [ON/OFF] to 

turn on or off the enable limit. 

3. After setting the software limit information of all axes, click the [Save] button to make 

the setting effective immediately. 

 

Pic 5-8 Software limit setting 
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5.9 Current limit 

Description        

By setting the current limit switch, the current range of each axis can be limited. The unit is ampere. 

When a certain axis reaches or exceeds the set current limit value, it will alarm and stop for 

protection. (This version is reserved and not open temporarily) 

Steps   

1. Click the option in the menu bar, and then click "Put into service → Current limit 

switch" to enter the current limit setting interface. 

2. Select an axis, edit the limit data in the table, and click Limit Enable [On/Off] to turn 

on or off the enable limit. 

3. After setting the software limit information of all axes, click the [Save] button to make 

the setting effective immediately. 

 

Pic 5-19 Current limit setting 

5.10 Area configuration 

Description   

Area types include interference area, safe area, shared area, and invalid area. 

【The area configuration contains the following parameters】 

Area refers to a spatial range. Has the following characteristics: 

（1）Origin. A reference point of the area relative to a user coordinate system. 

（2）Shape. The area is usually a solid based on the origin, and its shape can be box-like or column-

 

You can also click the external axis to switch to the external axis for external axis 

limit setting, the operation is the same as that of the internal axis. 
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like. 

A. Box-shaped with long, wide, high. 

 

Box shape 

B. Cylinder with a base radius and height. 

 

Cylindrical 

（3）Offset, the allowable error when judging the area inside/outside. (The current system version 

cannot accurately stop at the edge of the expansion value, and the stopping distance varies 

according to the movement position and speed) 

 

Note: The Offset can also be understood as the regional wall thickness. The safe zone 

is equivalent to increasing the wall thickness inward, and the interference/sharing zone 

is equivalent to increasing outward. In practical applications, the expansion value 

should be larger than the theoretical value to increase safety 

（4）Each area is configured with an external output signal (digital signal, area signal configuration 

see running configuration), used to indicate whether the robot position is in/out of the area, 

and whether the external output signal is reversed. 

When the area parameters are configured successfully, the external output signal will 

have corresponding output according to the signal inversion, regardless of the zone type. 

Signal reversal=true (open state), output outside the area=ON, and vice versa when inside the 

area; 

Signal reversal=false (closed state), enter the area, the area output=ON, and vice versa outside 

the area; 

（5）The processing mode can be processed according to the relationship between the robot position 

and the area (inside/outside) (different types of areas have specific definitions). Processing 

modes include: 
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A. Ignore 

B. Error Stop 

C. Warning Stop 

（6）Workpiece selection, can be selected according to the calibration of the workpiece, and 

determine the XYZ direction of the area 

Interference area (Block Area): refers to the area where the robot cannot enter or stay. 

Features: The robot is normal when it is outside the area, and it will alarm and stop when it is 

inside the area. 

Features: In manual mode (inching, inching, space movement)/automatic mode (T1, T2, 

AUTO, external), it is in the area and stops with an error. If the robot alarms in the area, 

you need to switch the area type to the invalid area, and then move the robot outside the 

area before the robot can perform subsequent movements. 

 

6 Jog 

6.1 Move Mode 

In jog mode, there are two kinds of move modes: incremental and continuous  

6.1.1 Continuous 

Operation procedure  

1. In jog mode, select “RUN KEY” coordinate 

2. Set jog override  

Next to the RUN KEY, following information is displayed: 

A1—A6: correspond to the axis number marked on the robot； 

、Y、Z： Used for linear movement along the axis of the selected coordinate system； 

、B、C： Used for rotary movement along the axis of the selected coordinate system。 

3. Press safety switch and enable is on now 

4. Press the positive or negative run key to make the robot move in the positive or negative  

direction 

 

The position of the robot during movement can be displayed by the  

following methods: 

Select main menu→display→actual position. For the first time, the  

current display is the Cartesian coordinate position by default. If the  

axis coordinate is displayed, you can click the Cartesian button on the  
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6.1.2 Incremental 

Description 

Incremental JOG operation mode can make the robot move a defined distance, such as 10 mm or 

3°. Then the robot stops by itself, or 0~10°/0~100mm custom inching distance. 

Applicable scope 

1. Positioning points at the same distance 

2. Move a defined distance from a location 

3. Use the measuring table to adjust 

Following options are available 

 

Setting Description 

Continuous Incremental jog move closed 

100mm/10° 1 increment =  100 mm or 10° 

10mm/3° 1 increment =  10 mm or 3° 

1mm/1° 1 increment =  1 mm or 1° 

0.1mm/0.005° 1increment =  0.1mm or 0.005° 

mm：Applicable to cartesian movement 

Degree: Applicable to axis movement 

 

right to switch. 

 

If the movement of the robot is interrupted, such as the safety switch is 

released, then the interrupted increment in the next action will not continue, 

but a new increment from the current position will start up. 
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Figure 6-1 Incremental Jog movement 

6.2 Jog Override 

Description  

Override is the speed of the robot at runtime. It is expressed as a percentage. 

Operation procedure 

1. Touch the override adjustment status icon to open the override adjustment window, and the 

override will be adjusted after pressing the corresponding button or dragging. 

2. You can set the desired manual override through the plus and minus keys or the screen 

adjuster 

Plus and minus keys: can be set in units of steps such as 100%, 75%, 50%, 30%, 10%, 3%, 

1% 

Adjuster: It can be set in 1% steps. 

Notes: In Jog mode, jog override can be only adjusted; in auto mode, auto override can be only 

adjusted. 
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Figure 6-2 Jog override display and adjustment 

 

6.3 Tool selection and workpiece selection 

Description: Up to 16 tool coordinate systems and 16 workpiece coordinate systems can be stored 

in the robot control system 
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 Figure 6-3 Tool & Workpiece Coordinate System 

Operation Process: 

1. Touch the tool and workpiece coordinate status icon to open the "active tool/workpiece 

coordinate" window. 

2. Select the required tool and workpiece coordinates. 

 

Notes: 

Before loading the program, the current actual position is displayed based on the tool workpiece 

selected by the user. After loading the program (not running) successfully, the tool workpiece 

coordinate system is displayed as the default, regardless of the non-default tool workpiece 

coordinate system selected before loading. After running the program, the tool workpiece coordinate 

system is displayed in accordance with the tool workpiece coordinate system called in the program. 

If there is no call, the default tool workpiece coordinate system is used and displayed. When the 

program is unloaded, it will be restored to the tool workpiece number called before loading. 

 

Take currently used tool and workpiece 

coordinate system shown above as the standard 

to show the current actual position. 
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6.4 Show the current actual position 

Operation procedure 

1. Select the main menu display→actual position. The actual Cartesian position will be displayed. 

2. Click Axis to display the actual position related to the axis. 

3. Tap Cartesian to display the actual Cartesian position again. 

Description 

Cartesian actual position: 

Display the current position (X, Y, Z) and direction (A, B, C) of the TCP. 

The actual position of the axis: 

The current positions of the axes A1 to A6 will be displayed. If there is an additional axis, the 

position of the additional axis is also displayed. 

While the robot is running, the actual position of each axis will be updated in real time. 

 

Figure 6-4-1 Cartesian actual position 

 

Figure 6-4-2 Articulate actual position 

6.5 Move to point 

Huashu Ⅲ type control system provides the function of moving to the point. 

The procedures are as follows: 
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Main menu display→Select JR/LR in the variable list→click "change"→enter the target 

coordinates→press the safety switch→lick "joint to point" or "straight to point" to run the robot to 

the target point. 

If it is a program editing interface, the procedures are as follows: 

select the motion command line→press the safety switch→click "joint to point" or "straight to 

point" to achieve this function. 

Notes: 

Under the JR/LR editing interface of variable list in manual mode, it supports movement to point in 

non-running state 

Supplement: Function of moving to point has the movement status display function, as shown in the 

figures below. The left picture is "movement state". The right picture is "stop" 

                                        

Figure 6-5 Display of moving to point 

6.6 P point online editing 

Description 

P point online editing and modification function. In manual mode and non-running state (suspended 

or ready state), it can jog the manipulator, and record points, and resume program operation. The 

program will execute the movement according to the latest recorded point. 

Steps:  

1. In manual mode, select the motion instruction program line to be modified (P or JR/LR). 

2. JOG to adjust the position of the robot arm, and click the record button to finish the modification. 

 

Note: Since the Cartesian coordinate LR has different morphological 

positions, and it is non-manual "acquisition of coordinates", the coordinates 

need to be entered manually. 

After confirmation, the morphological position can be generated before it 

can move to the point correctly. 
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Figure 6-6 P point online modification 

7 Auto Running 

Operation Procedure 

1. Select running mode: T1/T2/Auto mode 

2. Select the program to be run in the navigator interface and click "Load" 

3. In T1/T2 mode, press the safety switch and do not release it during program running; in auto 

mode, click the enable button at the top left of the screen to turn on the enable. 

4. Adjust the speed override to an appropriate value. 

5. After the program is displayed on the top of the teach pendant as "ready", click the physical run 

button on the left side of the teach pendant to start running the program (for the functions of the 

physical buttons on the left, please refer to section 4.1 Washu III Teach Pendant-Front View ) 

6. During the running of the program, click the corresponding physical button to pause and stop the 

program. 

 

The recorded point will directly overwrite the original value, and this 

operation cannot be undone and restored. 
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【Remarks】 

1. It is not allowed to switch modes during the running of the program 

2. It is not allowed to edit the program while the program is running 

8 Emergency stop 

The emergency stop switch is used for emergency stop of the robot movement and located at the 

upper right of the teach pendant (red button). 

Operation procedure 

1. In an emergency, press down the emergency stop button on the upper right of the teach pendant 

2. Turn the emergency stop button clockwise to release the emergency stop switch 

3. In the teach pendant status display window, click "Alarm Confirm" to clear the emergency stop 

error 

9 Dual code control 

Description   

The dual-code joint control is used to run the program virtual iteratively to optimize the optimal 

motion trajectory speed, and add motion parameters to the motion instructions. 

Operation procedure 

1. Click the cursor to select the program to be optimized. (Note: It is recommended to keep the 

original program and copy the program before optimization). 

2. Click the "More-Optimization" button in the lower corner. After a period of time, when the 

program is optimized, the color of the program will be green. 

 

Optimized 

Backups 
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Figure 9-1  Image after optimization 

 

10 Jump function 

Description  

In manual mode, the program supports jump operation. If the program pointer jumps to the selected 

line to run again, it will execute sequentially from the selected line. 

Operation procedure 

1. In manual mode, load a program and enable it manually 

 

Note: The process of program optimization is virtual execution, and it cannot 

be enabled; 

The optimization program only optimizes the motion instructions (straight 

line and arc); 

After optimization, new motion parameters will be inserted into the program. 

If you need to keep it, you can copy the program before optimization; 

The flag bit of the optimized program is displayed in green. If the program 

has been modified, the original flag color will be restored, which can be 

optimized multiple times; 

The optimized program is not an absolute ideal speed trajectory, it can be 

used as a reference and second modification and debugging; operation is not 

allowed during the optimization process. 
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2. Select any line of instructions in the program to click the "Run" button and the running pointer 

of the program running interface jumps to the selected line 

3. Click the "Run" button again, the program will execute the current instruction. If the current 

operating mode is single-step operation, the running pointer will point to the next instruction after 

the instruction of this line is executed;  

If the current operation mode is continuous operation, the program will continue to execute 

downwards after the current instruction is executed, until the program is completed. 

11 Process package 

Description    

The process package is the expansion module function of the teach pendant, which mainly simplifies 

the process flow, parameter data operation and calculation, etc., and the corresponding process 

package needs to be installed. 

Operation procedure  

1. Click the "process package" button in the first level menu bar to enter the process package 

selection interface. (The options will only be displayed when the technology package is installed) 

2. Click the option of process package name to successfully enter the process package interface. 

12 Fallback function 

Description 

The function of the fallback function is to load the program in manual mode, and enable it. Each 

time the back button is clicked, the robot backs up and executes the instruction pointed by the back 

pointer in the currently loaded program. 

 

Fallback function and fallback rule: 

 

The jump function can be used with the backward function. When back 

function is operating, the motion instruction is only executed, and other 

instructions are ignored and not executed. 

 

If the back pointer is displayed in the program, it proves that the back pointer 

can be backed in the current scenario. If the back pointer is not displayed, it 

proves that the back pointer cannot be backed back in the current scenario. 

Pressing the back button will prompt the corresponding alarm information. 
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Command  Fallback processing method 

Movement command（J、L、C） Based on the motion attribute and motion mode 

of the last executed motion instruction, move to 

the target point of the movement instruction 

recorded by the back pointer 

Condition command  Ignore  

Flow command 

CALL Ignore 

GOTO、LBL Encountering this instruction, Fallback is not 

allowed 

Cycle command（FOR、END FOR、WHILE、

END WHILE、BREAK） 

Ignore 

IO（DO、WAIT、PULSE） Ignore 

Program control command（PALSE、ABORT、

END） 

Encountering this instruction, Fallback is not 

allowed 

Other command（THROW、RUN、SET_TR、

SET_TOOL、SET_FRAME） 

Ignore 

Assignment command Ignore 

Move command attribute （VEL、VROT、CNT、

CNT_TYPE、ACC、DEC、SKIP） 

Ignore 

Move command 

contains additional 

commands 

OFFSET 1. If the additional command is a direct position 

compensation instruction (for example: L 

P[0] ,OFFSET LR[2]), it can execute the 

fallback. Using the movement attribute and 

movement method of the last executed 

movement instruction to move to the point, 

which is the target point recorded by the motion 

instruction recorded by the back pointer plus the 

compensation amount 

2. If the additional command is a position 

compensation command (example: 

LP[0] ,OFFSET), as long as the conditional 

compensation instruction has been executed 

once (for example: the global assignment 

instruction OFFSET_CONDITION=LR[2]), the 

fallback can be executed. If it has not been 
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executed, the fallback cannot be executed, and 

the robot stops running and alarms 

TOOL_OFFSET 1. If the additional command is a direct tool 

compensation instruction (for example: L 

P[0] ,OFFSET LR[2]), it can execute the 

fallback. Using the movement attribute and 

movement method of the last executed 

movement instruction to move to the point, 

which is the target point recorded by the motion 

instruction recorded by the back pointer plus the 

compensation amount 

2. If the additional command is a position 

compensation command (example: 

L P[0] ,TOOL_OFFSET), as long as the 

conditional compensation instruction has been 

executed once (for example: the global 

assignment instruction 

TOOL_OFFSET_CONDITION=LR[2]), the 

fallback can be executed. If it has not been 

executed, the fallback cannot be executed, and 

the robot stops running and alarms 

INC Encountering this instruction, Fallback is not 

allowed 

Jump 

Jump to move 

command 

Both the sequence and fallback pointers point to 

the line of instructions, and rollback is executed. 

Use the movement attribute and movement 

mode of the instruction pointed by the back 

pointer to back to the target point recorded by 

the instruction in this line. 

After the fallback is completed, the sequence 

pointer moves down after the execution is 

completed, and the backward pointer moves up 

Instructions that will 

be ignored when 

jumping to fallback 

The sequence pointer executes the jump 

instruction, and the rollback pointer points to the 

most recent motion instruction above the 
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instruction to be jumped (provided that there is 

no unexecuted fallback instruction between the 

two instructions) 

Jump to a non-

executed fallback 

instruction 

The sequence pointer executes the jump 

instruction, the fallback pointer is not displayed, 

and the fallback alarm is executed 

The point data recorded by the motion command 

is inconsistent with the currently displayed tool 

and workpiece coordinate system 

Fallback operation is not allowed, and it will 

alarm. 

 

 

13 Document function 

13.1 File Management Navigator 

Description  

Users can manage programs and files related all system in the navigator. 

Header line 

Right area: Display the files in the selected directory in the directory structure. ([Open] button can 

open the corresponding folder) 

Directory Structure 

Directory overview. 

Click to display the directory list  

Document list 

Display the contents of the directories marked in the directory structure. 

 

Note:  

①If the sequence pointer and the retreat pointer point to different programs, 

the display of the interface is based on the program where the sequence 

pointer is located. 

②It can only be back in manual mode, and the default is single step. 
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Figure 13-1 Navigator interface 

13.2 New Folder 

Operation procedure 

1. Select the folder where you want to create the file in the directory structure 

2. Click New Folder 

3. Select a program or folder 

4. Give the name of the new file (the name cannot contain spaces) and press the "OK" button. 
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Figure 13-2 New program or folder 

 

13.3 Backup and restore settings 

Description  

Used for backup and restore of navigator interface files 

Operation procedure 

1. Click "Main Menu→File→Backup and Restore Settings" to open the "Backup/Restore Settings" 

dialog box 

2. Set the backup and restore path to udisk (U disk) or the default path (the default path is stored in 

 

Note: The group mask is used to define the attributes of the program, and the 

default is 0. 

*Indicate logic instruction program (non-motion instruction program), and 

use for RUN multi-thread program. 
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the teaching local), and the backup and restore path can be manually entered under super authority. 

3. Select the file you want to back up in the navigator interface and click Backup to complete the 

backup. The backup file is located in the set path 

4. In the navigator interface, click the restore button, the files under the set restore path will be 

displayed. Select the option that needs to be restored and click the OK button to complete the file 

restoration. If you are restoring from a U disk, you need to insert the U disk first. 

 

 

Figure 13-3 Backup and restore settings 

13.4 File lock and unlock 

Operation procedure 

 

The program files of the teach pendant are stored in the SD/HSpad/program/ 

directory under the [ES file browser] app. After connecting the U disk, you 

can also scan to udisk (U disk directory) under the ES file browser interface. 
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File lock 

1. Mark files in the directory structure. 

2. Select Edit→Lock, and click the "Lock" button in the prompt box. 

3. After locking, the selected file icon will display a lock style. 

Unlock： 

1. Select the locked file in the file directory. 

2. Select Edit→Lock, and click the "Unlock" button in the prompt box. 

3. Enter the unlock password and click OK to unlock the currently selected file. 

4. The initial password for unlocking is "hspad". 

Change unlock password: 

1. Select File→Lock Password Setting in the main menu. 

2. After entering the original password and the new password, click the "OK" button to save the 

new password. 

 

 

 
Figure 13-4 Set lock password 

 

Locking can only be performed on files. 

The locked files cannot be renamed, deleted, or opened. 
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13.5 Register file management 

Description   

This function is divided into two parts: obtaining register file and sending register file (variable list 

register file). 

Obtain the controller register file through the U disk, and send the register file to restore the 

controller's register data. 

Operation procedure        

1. Select menu bar→file→get register file. 

2. Click to select the "Group Number" drop-down box option (0 is selected by default). 

3. Check the check box and select the file to be sent or obtained. 

4. Click the "Get File"/"Send File" button. 

5. Click the "OK" button to confirm the operation. 

             

 

 

Figure 13-5 Obtain sending register file 

 

The obtained register file is stored in the U disk/udisk/regfile/ folder. 

 

Send the register file and also need to put the sent file in the U 

disk/udisk/regfile folder. (Send the register file to take effect after restarting 

the system) 
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13.6 File/folder deletion 

Operation procedure Mark files or folders in the directory structure. 

Choose "Edit→Delete". (File is not locked) 

Click the confirmation button in the dialog box, and the marked file or folder will be removed. 

13.7 Select or open program 

Overview   

You can select or open a program. A program editor will be displayed instead of the navigator. You 

can switch back and forth between the program display and the navigator. 

Differences  The program is loaded: 

1. The statement pointer will be displayed. 

2. The program can be started. 

3. Press Edit→Navigation. After canceling loading, press Program to enter the program editor, 

where you can change the program. 

 

The program is open: 

1. The program cannot be started. 

2. The program can be edited. 

3. The opened program is suitable for editing by the person who debugs the program. 

4. When closing, a dialog box will pop up asking whether to save the file. 

5. After editing the program, you can load the program only after saving or exiting without saving. 

13.8 Loading and canceling loading programs 

Operation procedure   

1. Select the program in the navigator and press Load. 

2. The program will be displayed in the editor, the selected program will be loaded into the editor, 

the corresponding open file will always be displayed in the editor, and the running cursor will be 

displayed at the same time. 

3. Cancel loading program: select "More→Cancel loading program" or directly press the "Cancel 

loading" button. If the program is running, the program must be stopped before canceling the 

program selection. 
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13.9 Log file management 

Description  

This function provides access to related log functions such as controller and teach pendant operation 

Operation procedure 

1. Click to select the menu bar-file-log file management option to enter the log file management 

interface. 

2. Tick the check box of the log objects required. 

3. When the U disk has been inserted into the teach pendant and it is guaranteed to be recognized, 

click the [Get File] button to pop up the path selection interface. 

4. Click the [OK] button to send the log file to this folder. 

 

Figure 13-9 Obtain log files 

 

Log can be sent to relevant personnel for problem analysis 
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14 Display function 

14.1 Display digital input/output Terminal 

 

Operation procedure  

1. Select Display→Input/Output→Digital Input/Output in the main menu. 

2. Click to select a specific input/output, and operate the IO through the buttons on the right side of 

the interface. 

 

Figure 14-1-1 Digital input 

 

The input terminal REAL can only give signals through real external pulses, 

while VIRTUAL can give pulse signals through the teach pendant. 



 

 57 

 

Figure 14-1-2 Digital output 

 

No.: Description 

Serial No.: Digital input/output serial number 

IO number Digital input/output IO number 

Value 
Input/output value. If an input or output is TRUE, it is marked in 

red. Click the value to switch the value to TRUE or FALSE. 

Status 

Indicates that the digital input/output terminal is real IO or virtual 

IO. Real IO is displayed as REAL, and virtual IO is displayed as 

VIRTUAL. 

Description Add a description to the digital input/output terminal. 

-100 Switch to the previous 100 inputs or outputs in the display. 

100 Switch to the next 100 inputs or outputs in the display. 
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Switch Can switch between virtual and actual input/output. 

Value The selected IO can be set to TRUE or FALSE. 

Description 
Add an explanation to the digital input/output of the selected row, 

and click to change it after selecting it. 

Save Save IO description  

14.2 External automatic operation 

Description 

Configuring external signals is the process of establishing a mapping relationship between system 

signals and IO input and output indexes (the function is bound to IO). After the mapping relationship 

is established, the program can be executed through the IO signal and the robot status can be 

obtained. All system signals must be configured before they can be mapped to the corresponding 

IO points. In a system without external signal configuration, there is no mapping connection 

between system signals and IO by default. 

 

 

Operation procedure  

Run input and output configuration: 

1. Select "Configuration→Input/Output→Run Configuration" in the main menu to enter the run 

configuration interface. 

2. Click "input configuration", select the [flag] on the left side of the screen, select the DIN index 

number on the right, and click to add "<—" to establish a mapping relationship, and click to remove 

"—>" to cancel the mapping relationship . 

3. Click "Save" to save the operation. 

4. Click "Output Configuration", similar to the above operation, you can set the output mapping 

relationship. 

 

Note: The running configuration can only be operated in manual mode T1/T2 

Input configuration: By binding the specified input signal and triggering the 

input signal, complete the normal operation of the external program, such as: 

enable, load, pause, run the program, clear the alarm, etc. 

Output configuration: through output signals, display some states of the 

robot, such as: program state, enable state, current mode, area output, etc. 
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Figure 14-2-1 Run input configuration 
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Figure 14-2-2 Run output configuration 

 

System input signal table 

Signal name Description Effective way Applicable scope 

iPRG_START 
Start program signal. Start the loaded 

user program to run.  

Falling edge takes 

effect 

Automatic mode, 

external mode 

iPRG_PAUSE 
Pause the program signal. Suspend 

user program running. 

Falling edge takes 

effect  

Automatic mode, 

external mode 

 

Note: The running configuration can only be operated in manual mode 

T1/T2. 

Note: When the external program is ready, it can be unloaded through the 

unload signal. Program in running state, pause program signal → stop 

program signal (complete uninstall program)/or stop program signal → 

uninstall program signal (complete uninstall program) 
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iPRG_STOP 
Stop the program signal. Stop the user 

program and uninstall the program. 

Falling edge takes 

effect 

Automatic mode, 

external mode 

iPRG_LOAD 
Load program signal. Load the 

specified user program. 

Rising edge takes 

effect 

External mode 

iPRG_UNLOAD 

Uninstall the program signal. 

Uninstall the program in the ready 

state. 

Falling edge takes 

effect 

Automatic mode, 

external mode 

iENABLE System enable signal.  
Rising edge enable, 

set 0 to disable enable 

Automatic mode, 

external mode 

iCLEAR_FAULTS Clear the error signal. 
Rising edge takes 

effect 

Automatic mode, 

external mode 

iSHARED_EN[0] Shared area [0] enable switch. 
Rising edge enable to 

open, set 0 to close  

Manual mode, 

automatic mode, 

external mode 

iSHARED_EN[1] Shared area [1] enable switch 

Rising edge enable to 

turn on, set to 0 to 

turn off 

Same as above 

iSHARED_EN[2] Shared area [2] enable switch 

Rising edge enable to 

turn on, set to 0 to 

turn off 

Same as above 

iSHARED_EN[3] Shared area [3] enable switch 

rising edge enable to 

turn on, set to 0 to 

turn off 

Same as above 

iSHARED_EN[4] Shared area [4] enable switch 

Rising edge enable to 

turn on, set to 0 to 

turn off 

Same as above 

iSHARED_EN[5] Shared area [5] enable switch 

Rising edge enable to 

turn on, set to 0 to 

turn off 

Same as above 

iSHARED_EN[6] Shared area [6] enable switch 

Rising edge enable to 

turn on, set to 0 to 

turn off 

Same as above 

iSHARED_EN[7] Shared area [7] enable switch 

Rising edge enable to 

turn on, set to 0 to 

turn off 

Same as above 
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iSHARED_EN[8] Shared area [8] enable switch 

Rising edge enable to 

turn on, set to 0 to 

turn off 

Same as above 

iSHARED_EN[9] Shared area [9] enable switch 

Rising edge enable to 

turn on, set to 0 to 

turn off 

Same as above 

iSHARED_EN[10] Shared area [10] enable switch 

Rising edge enable to 

turn on, set to 0 to 

turn off 

Same as above 

iSHARED_EN[11] Shared area [11] enable switch 

Rising edge enable to 

turn on, set to 0 to 

turn off 

Same as above 

iSHARED_EN[12] Shared area [12] enable switch 

Rising edge enable to 

turn on, set to 0 to 

turn off 

Same as above 

iSHARED_EN[13] Shared area [13] enable switch 

Rising edge enable to 

turn on, set to 0 to 

turn off 

Same as above 

iSHARED_EN[14] Shared area [14] enable switch 

Rising edge enable to 

turn on, set to 0 to 

turn off 

Same as above 

iSHARED_EN[15] Shared area [15] enable switch 

Rising edge enable to 

turn on, set to 0 to 

turn off 

Same as above 

 

System output signal sheet 

Signal Description Notes 
Applicable 

scope 

oROBOT_READY 

The robot Ready signal. When the system is 

initialized, the user program is in the loaded 

state and the signal is output when it is 

enabled. 

This signal will not 

be output during 

program operation 

ALL modes 

oDRV_FAULTS Error  ALL modes 

oENABLE_STATE Enable state.  ALL modes 

oPRG_UNLOAD The user program is not loaded. At the same time, ALL modes 
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oPRG_READY The user program has been loaded. these signals have 

only one to output 

ALL modes 

oPRG_RUNNING User program running status. ALL modes 

oPRG_ERR User program alarm status. ALL modes 

oPRG_PAUSE The user program is paused ALL modes  

ols_Moving The robot is moving  ALL modes  

oMANUAL_MODE The system is in JOG mode. At the same time, 

these signals have 

only one to output 

ALL modes  

oAUTO_MODE The system is in auto mode. ALL modes  

oEXT_MODE The system is in external mode. ALL modes  

oHOME Currently at the zero position  ALL modes  

oMD_ENABLED MoDBuS enable switch  

Reserved, 

temporarily 

unavailable 

ALL modes  

oMD_CONN ModBus connection status 

Reserved, 

temporarily 

unavailable 

ALL modes  

oREF[0] Reference point [0]  ALL modes 

oREF[1] Reference point [1]  ALL modes  

oREF[2] Reference point [2]  ALL modes  

oREF[3] Reference point [3]  ALL modes  

oREF[4] Reference point [4]  ALL modes  

oREF[5] Reference point [5]  ALL modes  

oREF[6] Reference point [6]  ALL modes  

oREF[7] Reference point [7]  ALL modes  

oAREA_OUT[0] Area [0] output signal  ALL modes  

oAREA_OUT[1] Area [1] output signal  ALL modes  

oAREA_OUT[2] Area [2] output signal  ALL modes  

oAREA_OUT[3] Area [3] output signal  ALL modes  

oAREA_OUT[4] Area [4] output signal  ALL modes  

oAREA_OUT[5] Area [5] output signal  ALL modes  

oAREA_OUT[6] Area [6] output signal  ALL modes  

oAREA_OUT[7] Area [7] output signal  ALL modes  

oAREA_OUT[8] Area [8] output signal  ALL modes  

oAREA_OUT[9] Area [9] output signal  ALL modes  
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oAREA_OUT[10] Area [10] output signal  ALL modes  

oAREA_OUT[11] Area [11] output signal  ALL modes 

oAREA_OUT[12] Area [12] output signal  ALL modes  

oAREA_OUT[13] Area [13] output signal  ALL modes  

oAREA_OUT[14] Area [14] output signal  ALL modes  

oAREA_OUT[15] Area [15] output signal  ALL modes  

 

Run program configuration 

4. Click the "Program Mapping Register-Modify" button and enter the R register  

index number. 

5. Click the "Program Mapping Register-OK" button to complete the setting of the 

program mapping register. 

6. Click the cursor to select any serial number, and click the "Configure" button. 

(There are 256 index numbers, and 256 external programs can be configured at the 

same time) 

7. The program selection interface pops up, click to select the program to run. 

8. Click the "OK" button to complete the external program configuration. 

9. Click "Save" on the operation bar to complete the external program configuration 

 

 

 

After the external program is configured, if the program is modified 

(including subprograms) or is loaded for the first time, it needs to be loaded 

again in manual or automatic mode, and the program is issued and updated 

to the controller. 

 

Assuming that the program mapping register is R[1], when R[1]=2, the 

external mode loads the program with index number 2; when it is 0, loads 

the program with external configuration index number 0, passing the value 

of R register in total , load different programs. 
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Figure 14-2-3 Run-program configuration 

Reference configuration: 

10. Click the "reference configuration" button to enter the reference configuration    

interface. 

11. Click the "Add" button to set the "reference number", "register" index number, 

and "precision". 

12. Click the "OK" button to complete the setting. 

13. Switch the mode to the external mode, you can operate the robot by triggering 

the IO signal. Switch the real IO signal or the menu bar "display-input/output-digital 

input/output" interface to the Virtual state, and debug the teach pendant to externally 

run. 

 

Reference configuration function: the designated JR register can be 

configured, when the robot is currently in the position of the designated JR 

register (for example: JR[0]={0,-90,180,0,90,0}). 

When the current actual position of the robot is equal to the coordinate, the 

signal of the bound position is output, the accuracy range can be set, and 8 

JR registers can be bound. 
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Figure 14-2-4 Run configuration-program configuration 

14.3 Variable list 

Operation procedure 

1. Select the main menu display→variable list. A list of related variables will be displayed. 

2. Click the list of different variables, and the related variables will be displayed. 

3. The function buttons on the right can be used to turn pages, modify and save registers. 

4. All modified operations must be saved in the file after clicking Save 

Description  

Variable list is used to have different types of register data 

UT：Tool coordinate system variable 

UF：Base coordinate system variable 

R ：Value register 

JR：Joint type coordinate register 

LR：Cartesian coordinate register 

 

After setting the register, you need to click [Save] to save, and the unsaved 

will be lost after power off and restart. 
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Figure 14-3 Variable list 

15 Diagnosis 

15.1 Run log 

Description    

The teach pendant provides a log function, and you can view the generated running log. 

Operation procedure 

1. Select Diagnosis→Run Log in the main menu to display the Run Log window. 

Key Description 

Number Description 

Log header Jump to log header 

Log end Jump to the end of the log 

-100 Turn up 100 entries in the log. 

100 100 Scroll down 100 logs. 

Output Output the currently displayed log to a file 

Refresh Refresh the current log 

Filter Set log filter display conditions 
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Figure 15-1Run log 

15.1.1 Filter 

Description 

The specified content can be filtered and filtered. 

Operation procedure 

1. Click the filter button on the run log interface. 

2. Set the log content to be displayed. 

3. After clicking OK, it will return to the running log interface and display the filtered 

log content. 

 

 

 



 

 69 

 

Figure 15-1-2 Run log-filter 

15.1.2 Log configuration 

Operation procedure 

1. Click on the main menu and select Diagnosis→Run Log→Configuration to display the log 

configuration interface 

2. Set the log output file, etc 

3. Click the "OK" button. 
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Figure 15-1-3 Log setting 

16 Calibration of tool/workpiece 

16.1 Base coordinate three-point calibration 

Operation procedure 

1. In the menu, select Put into operation→Measure→User part calibration. 

2. Select the user workpiece number to be calibrated, and set the user workpiece name. 

3. Click the [Start Calibration] button. 

4. Move to the origin of the base coordinates and click [Origin] to obtain the origin coordinates of 

the coordinate record. 

5. Move to a point in the X direction of the calibration base coordinate, and click [X direction] to 

obtain the coordinate record coordinates. 
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6. Move to a certain point in the Y direction of the calibration base coordinates and click [Y direction] 

to obtain the coordinate record coordinates. 

7. Click the [Calibration] button to confirm that the program calculates the calibration coordinates 

8. Click the [Save] button to store the calibration value of the base coordinates 

9. Switch to the user coordinate system, select the calibrated workpiece number, and move in the 

XYZ direction, and it will move in the calibrated direction. 

 

Figure 16-1 Base coordinate calibration 

16.2 Four-point calibration of Tool calibration 

Description 

Move the TCP of the tool to be measured from 4 different directions to a reference point. The 

reference point can be selected arbitrarily. The robot control system calculates the TCP from the 

different flange position values. The four flange positions used to move to the reference point must 

be spread enough apart. 
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Operation procedure 

1. Select Put into Operation→Measure→User Tool Calibration in the menu 

2. Select the user tool number to be calibrated, and set the user tool name. 

3. Click the [Start Calibration] button. 

4. Move to a certain point of the calibrated reference point 1, and click [reference point 1] to obtain 

the coordinate record coordinates. 

5. Move to a certain point of the calibrated reference point 2 and click [reference point 2] to obtain 

the coordinate record coordinates. 

6. Move to a certain point of the calibrated reference point 3, click [reference point 3] to obtain the 

coordinate record coordinates. 

7. Move to a certain point of the calibrated reference point 4, click [reference point 4] to obtain the 

coordinate record coordinates. 

8. Click the [Calibration] button to confirm that the program calculates the calibration coordinates 

9. Click the [Save] button to store the calibration value of the tool coordinate 

10. Switch to the tool coordinate system. Select the calibrated tool number, and go in the ABC 

direction, then the robot tool TCP will rotate around the workpiece. 
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Figure 16-2 Tool coordinate calibration 

16.3 6-point calibration of tool coordinates 

Description 

Similar to the 4-point method, the 6-point method can calibrate the posture of the tool. When 

recording points, the fifth and sixth points are used to record points on the z-axis and zx plane of 

the tool respectively. The method refers to the 4-point method. 

17 Help  

17.1 Information  

In the main menu, select Help→Information. In the opened window, you can view the version 
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information of the current teach pendant and the controller (controller version information, click the 

drop-down icon option). You can see the version description in the "Version Information" interface. 

 

Figure 17-1 Information display window 

18 System 

18.1 System language setting 

Description    The teach pendant provides the choice of alarm language 
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Figure 18-1 Language setting 

 

Operation procedure 

In the main menu, select System→Language Selection, the language selection dialog box is 

displayed, and the alarm language is selected. 

18.2 Restart the teach pendant 

Operation procedure 

In the main menu, select System → Restart teach pendant, and select "OK" in the pop-up dialog 

box to Restart teach pendant 

18.3 Clean up the system 

Description 
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This function is used to release the storage space of the controller and clean up the remaining 

upgrade package files. The system must be cleaned up first when upgrading the system version 

Operation procedure 

Select System→Clean System in the main menu, and select "OK" in the pop-up dialog box to 

complete the cleaning work 

18.4 Restart the system 

Description 

This function is used to restart the Type III teach pendant, and is different from power-off restart (in 

some scenarios, power-off restart is required to restart the system). 

Operation procedure 

Select System→Restart System in the main menu, and select "OK" in the pop-up dialog box to 

restart the teach pendant 

 

Some settings need to restart the system to take effect, such as: load, send 

register file, etc. 

18.5 Shut down the system 

Operation procedure 

Open the menu, click "System→Shutdown" in turn, and select "OK" in the pop-up dialog box to 

close the controller system. 

18.6 System Upgrade 

Description 

In the teach pendant, an upgrade function is provided, which is convenient for users to upgrade 

directly on the teach pendant. The upgrade file extension is .tar.gz. 

Operation procedure 

1. Select System→Upgrade System in the main menu to display the upgrade window. 

2. Select the file to be upgraded. 

3. Click to Send Update Package. 

4. Power off and restart the control system 
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Note: Before upgrading the system, return the robot to the zero 

position first, and power off and restart once or power on for the first 

time. Do not perform any operation before performing the upgrade 

operation. Need [Clean up the system] to free up space 

 

 

Figure 18-2 Upgrade the system 

18.7 Import and export PLC of users 

Description 

With the function “ import and export PLC of users”, you can back up the user’s PLC in the existing 

controller system through the U disk, or import a new user’s PLC to update/restore the system 

environment. 

Steps of exporting PLC of users    

1. Insert the U disk, after the U disk is successfully recognized 

2. Open the menu and click "System→Import and Export User PLC"  
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3. Click the [Select Directory] key of the export module to confirm the export path 

4. Click the [Export] key, after prompting that the export is successful, the corresponding file will 

be found under the selected export path 

 

Figure 18-3 Import and export user’s PLC-1 

Steps of importing user’s PLC  

1. Insert the U disk, after the U disk is successfully identified 

2. Open the menu and click "System→Import and Export User PLC" 

3. Click the [Select File] key of the import module (select the app file) to confirm that you want to 

import the file 

4. Click the [Select File] key of the import module (select the crc file), and confirm that you want 

to import the file 

5. Click the [Import] key, prompt message "Importing file is successful, please power off and restart 

the controller!" The imported user PLC will take effect after power off and the restart. 

 

 
Figure 18-4 Import and export user’s PLC-1 

18.8 Import and export calibration parameters 

Description 

 

When the network connection fails, the user PLC cannot be imported or  

exported 

Note: The PLC must match the controller 

version 
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With the function “ import and export calibration parameters”,  you can export the calibration 

parameters in the existing controller system through the U disk for backup, or import the calibration 

to restore the calibration parameters.  

Steps of importing/exporting calibration parameters    

1. Insert the U disk, after the U disk is successfully identified 

2. Open the menu and click "System→Import and Export Calibration Parameters"  

3. (Export) Click the [Select Directory] key (select directory) of the export module to confirm the 

selection. 

4. In the import/export calibration parameter interface, click the [Export] key to export the 

calibration parameters. 

5. (Import) Click the [Select File] key of the import module (select Calbration.zip) to confirm the 

selection. 

 

In the import/export calibration parameters interface, click the [Export] key, prompt message 

"Importing file is successful, please power off and restart the controller!" The imported calibration 

parameters will take effect after power off and the restart. 

 

Figure 18-5 Import and export calibration parameters 

 

 

When the network connection fails, the calibration parameters cannot be  

imported or exported 
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19 Programming instructions  

19.1 File and program structure  

Huashu III control system has only one program for users to use: PRG files, which support PRG 

programs to call other PRG programs, that is, the caller is [main program], and the called program 

is [subprogram]. 

19.1.1 Program structure  

The program is divided into three modules: axis initialization, variable declaration and main 

program. The structure is as follows： 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

<attr> 

VERSION:0 

GROUP:[0] 

<end> 

<pos> 

P[1]{GP:0,UF:-1,UT:-1,JNT:[-0.0, -89.998, 180.001, 0.001, 

89.994, 0.001, 0.0, 0.0, 0.0]}; 

P[2]{GP:0,UF:-1,UT:-1,CFG:[0, 0, 0, 0, 0, 1],LOC:[286.522, -

0.0, 232.473, 179.999, 0.0, 179.999, 0.0, 0.0, 0.0]}; 

<end> 

 

 

Binding business  

layer and axis group 

Define coordinate  

variables, declare variables 
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The above coordinate variables have customized coordinate type--- P point, and the joint 

coordinate JR and Cartesian coordinate LR of the register; 

19.1.2 Coordinate type 

Define a variable P[1] point, articulated coordinate, the meaning is as follows： 

 

 

 

 

P[1]{GP:0,UF:-1,UT:-1,JNT:[-0.0, -90.0, 180.0, 0.001, 90.0, 0.0, 0.0, 0.0, 0.0]}; 

Define a variable P[1] point, articulated coordinate, the meaning is as follows： 

 

 

 

 

 

P[2]{GP:0,UF:-1,UT:-1,CFG:[0,0,0,0,0,1],LOC:[530.0, -313.0, 500.0, 179.999, 0.0, 179.999, 

0.0, 0.0, 0.0]}; 

19.1.3 The main program calls other programs  

The main program calls other programs, the syntax is: CALL "program name", the program is 

executed here, call the subprogram, execute the program content of the subprogram, after the 

execution, return to the main program to continue execution (flow control, see details in 2.3 Process 

control instructions). [The interface program of the teach pendant is shown below] 

GP: axes group 

UF: Workpiece number 

UT: Tool number 

JNT: Joint 

coordinates 

6 internal axes+3 

external axes 

GP: axes group 

UF: Workpiece number、

UT: Tool number 

CFG: 

Morphology 

LOC: Cartesian coordinates 

6 internal axes + 3 external 

expansion axes 

6 个内部轴+3 个外部拓展

轴 

<program> 

 

LBL[1] 

J P[1] VEL=50 

L P[2] VEL=50 

C JR[1] LR[1] VEL=50 

GOTO LBL[1] 

 

<end> 

 

Main program:  

add sentence block 
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Figure 19-1 Program editing interface 

19.2 Overview of programming instructions 

The instructions type and the instructions contained in the type are as follows： 

Instructions Types Instructions 

Movement instruction 

J 

L 

C 

A 

Conditional instruction IF 
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SELECT 

Process instruction 

CALL 

GOTO 

LBL 

Loop instruction 

WHILE 

FOR 

BREAK 

IO instruction 

DO 

WAIT 

WAIT TIME 

PULSEE TIME 

Timeout instruction WAIT TIMOUT LBL 

 PULSE output pulse instruction PULSE TIME 

Program control instruction 

PAUSE 

ABORT 

END 

Other instructions 

THROW 

SET_TR 

RUN 

SET_TOOL 

SET_FREME 

Offset instruction 

OFFSET_CONDITION 

TOOL_OFFSET_CONDITION 

OFFSET 

TOOL_OFFSET 

INC 

Get coordinates instruction 
JPOS 

LPOS 

Positioning instruction FINE 
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Assignment instruction 

UFRAME_NUM 

UTOOL_NUM 

CNT 

J_VEL 

J_ACC 

J_DEC 

L_VEL 

L_ACC 

L_DEC 

L_VROT 

C_VEL 

C_ACC 

C_DEC 

C_VROT 

R 

JR 

LR 

P 

TIME 

Trim instruction VORD 

 Manual instruction Enter instructions manually 

 

19.2.1 Movement instruction 

Instruction     

The movement instructions include movement of joint J and movement of and linear L, as well as 

the C instruction for drawing an arc. 

Edit box for movement instructions： 

No. Instruction 

1 

Select instruction, can choose three kinds of instructions of J, L and C. When the C 

instruction is selected, two points will pop up in the dialog box to record the position. 

2 The name of the newly recorded point. When the cursor is located, you can click to 
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record joints or record Cartesian coordinates 

3 Set running speed 

4 

For parameter setting, you can add the attribute corresponding to the deleted point in 

the parameter setting dialog box. After editing the parameter, click OK to map the 

parameter to the point. 

5 Assign joint coordinate values to the newly recorded point 

6 Assign Cartesian coordinates to the newly recorded point 

7 

Click it to open a dialog box for modifying coordinates, open to manually modify the 

coordinate value (you need to record the point information firstly, and the modified 

coordinates correspond to the coordinate type recorded). 

8 

The value of the newly added point can be saved by creating a new JR register or LR 

register, and the relevant value can be found in the variable list to facilitate the use of 

the point value through the register in the future. 

19.2.1.1 J instruction and L instruction 

Description   

The J instruction takes the current position of a single axis or a certain group of axes (robot group) 

as the starting point to move a certain axis or a certain group of axes (robot group) to the target point 

position. The movement process does not carry out trajectory and posture control, that is, joint 

movement. 

Instruction sentence: 

 

 

 

Instruction Parameters（optional）： 

J instructions include a series optional movement paramenters，——VEL（speed）,CNT（smooth 

transition, ACC（speedup ratio）, DEC（reduction ratio） etc. After the parameters are set, it is 

only valid for the current motion. After the motion instruction ends, it will restore to the default 

value. If no parameter is set, it will run based on the default value of each parameter, such as the 

default parameter used by J P[2] above. 

J [target point] Optional Properties 

Example： 

J P[1] VEL=50 ACC=100 DEC=100  

J P[2]  
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Instruction Instruction： 

The L instruction takes the current position of the robot as the starting point and controls it to do 

[Linear Motion] within the Cartesian space. It is often used in occasions that requires trajectory 

control. The control object of this instruction can only be [Robot Group]. 

Instruction sentence: 

 

 

Instruction Parameters（optional）： 

 

L instructions include a series optional movement paramenters，——VEL（speed）,CNT（smooth 

transition）,ACC（speedup ratio）,DEC（reduction ratio）, VORT（Attitude speed）etc. After the 

parameters are set, it is only valid for the current motion. After the motion instruction ends, it will 

restore to the default value. If no parameter is set, it will run based on the default value of each 

parameter. 

Operation Steps 

1. Select the previous line of the instruction line which needs to be inserted. 

2. Select instruction→motion instruction→J or L. 

3. Enter the point name. 

4. Configure the parameters of the instruction (if no parameters are set, it will adopt the default 

motion parameters). 

5. Manually move the robot to the target posture or position. 

6. Select the point input box, click "Record Joint" or "Record Cartesian" (J instruction can only 

choose to record joint), the recorded coordinates will be displayed on the upper right of the 

instruction modification box. 

7. Click the "OK" in the operation column to add the J instruction/L instruction. 

Program example 

LBL[1] 

J  P[1]  VEL=100  ACC=60  DEC=60 

L  P[2]  VEL=800  ACC=100  DEC=100 

GOTO LBL[1] 

19.2.1.2 C instruction 

Description     

The C instruction takes the current position as the starting point, CIRCLEPOINT as the intermediate 

point, and TARGETPOINT as the end point. It controls the robot to perform arc trajectory 

L [target point] Optional Properties 

Example： 

L P[1] VEL=50 ACC=100 DEC=100 VROT=50 

L P[2] 
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movement in Cartesian space (three points form an arc), and the posture interpolation is attached. 

Instruction sentence: 

 

 

 

 

 

 

 

 

Instruction Parameters（optional）： 

C instructions include a series optional movement paramenters，——VEL（speed）,CNT（smooth 

transition）,ACC（speedup ratio）,DEC（reduction ratio）, VORT（Attitude speed）, etc. After 

the parameters are set, it is only valid for the current motion. After the motion instruction ends, it 

will restore to the default value. If no parameter is set, it will run based on the default value of each 

parameter. 

Operation Steps  

1. Select the previous line of the instruction line which needs to be inserted. 

2. Select instruction→motion instruction→C. 

3. Click the input box of the first point, move the robot to the required posture point or axis position, 

click to record joints or record Cartesian coordinates, completing the record of the first point of the 

arc. 

Enter the point name. 

4. Click the input box of the second point, move the robot to the required posture point or axis 

position, click to record joints or record Cartesian coordinates, completing the record of the target 

point of the arc. 

5. Set the parameters for the instruction 

C [circle point] [target point] Optional Properties} 

Example： 

L P[1]  

C P[2] P[3] 

‘State as below to perform 

 a complete circle 

L P[1] 

C P[2] P[3] 

C P[4] P[1]            

 

Comple

te circle 

P2 

P3 

P4 

P1 
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6. Click the "OK" in the operation column to add the C instruction. 

Program Example 

J  P[1]     VEL=100 

C P[2] P[3]  VEL=600  ACC=100  DEC=100 

19.2.1.3 A instruction 

Description:    

A instruction makes three points of the robot’s current position to form two arcs with the same radius, 

so that the first two points form an arc with one radius, the last two points form another arc with 

another radius, and points can be added and deleted between the two arcs. The motion attributes of 

the two arcs can be set as different attributes 

Operation Steps 

1. Select the previous line of the instruction line which needs to be inserted. 

2. Select instruction→motion instruction→A. 

3. Input the name of the point. 

4. Configure the parameters of the instruction (if no parameters are set, it will adopt the default 

motion parameters). 

5. Manually move the robot to the target posture or position. 

6. Select the point input box, click "Record Joint" or "Record Cartesian" (J instruction can only 

choose to record joint), the recorded coordinates will be displayed on the upper right of the 

instruction modification box. 

7. Click the "OK" in the operation column to add the J instruction/L instruction. 

  

 

Three points make an arc 

 

① The points on the circle can be added and deleted 

② Different motion attributes (speed, acceleration, CNT, tool offset, etc.) can be set 

for the middle and end points of the arc 

③ Each arc track has a different radius 
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19.2.1.4 Motion parameters  

Name Description 

VEL Speed 

CNT Smoothing factor 

CNT_TYPE Smoothing type 

ACC Speedup ratio 

DEC Reduction ratio 

A [target point] Optional Properties 

Exxample： 

J P[1] VEL =100 

A P[2] VEL =500 

A P[3] VEL =500 

A P[4] 

A P[5] 

L P[6] 

The sentence above means (see the figure below), when the first circular motion A command 

(line 2) is executed, the robot motion mode is linear motion, that is, the robot move from current 

point P[1] to the target point P[2] through linear motion, from P[2] to P[3] through circular arc 

motion, from P[3] to P[4] through circular arc movement, from P[4] to P[5] through circular arc 

movement, from P[5] to P [6] through linear movement. 
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VROT Posture speed 

SKIP Interrupt 

【Note】 

Instructions for interrupt instruction: add the motion parameter SKIP to the motion instruction and 

set the corresponding IO. During the movement of the current motion instruction, if the 

corresponding configured IO has a value (that is, there is a corresponding input and output value), 

when the condition is satisfied, the robot will immediately end the current movement and start 

executing the next line of the program. When the corresponding IO has no value before the robot 

moves to the target point, the robot will execute the current motion instruction and start executing 

the next line of the program after reaching the target point. 

Program example 

J  P[1] 

J  P[2]  SKIP DO[1]=ON  ‘If DO[1]=ON is real, skip the point P2. If DO[1]=ON is false, 

run to this point 

J  P[3] 

19.3 Conditional instruction 

Conditional instructions are used for the judgment and logic processing of the program condition. 

There are three types as follows 

 

 

 

 

 

 

 

 

19.3.1 IF …. ,GOTO LBL[] 

Description： 

Sentence：IF…. ,GOTO LBL[]，if the condition is true，execute the GOTO program block; when 

Conditi

onal 

command 
IF condition = T 

ure ，GOTO LBL[No.] 

IF condition=Ture，

CALL Name of 

program.PRG”  

SELECT CASE 

Condition 
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the condition is false, execute the program block of the next line sequentially.  

 

Example①：Realized by IF GOTO sentence, output condition R[1]=1, move to P1 point, 

R[2]=2, move to P2 point, R[3]=3, move to P3 point  

IF R[1] =1, GOTO LBL[1] 

IF R[1] =2, GOTO LBL[2] 

IF R[1] =3, GOTO LBL[3] 

GOTO LBL[4] 

LBL[1] 

J P[1] 

GOTO LBL[4] 

LBL[2] 

J P[2] 

GOTO LBL[4] 

LBL[3] 

J P[3] 

LBL[4] 

Example②：Realized by IF GOTO sentence，after looping the program for 3 times, exit 

the loop  

R[1] =0 

LBL[1] 

IF R[1]>3 GOTO LBL[2] 

J P[1] 

IF <condition> , GOTO LBL[1] 

                                                                 

Example： 

IF DI[1]=ON ,GOTO LBL[1]    ‘ 

J P[1] VEL=50 

J P[2] VEL=50                         

‘If the condition is true, go to the Label[1] 

LBL[1] 

DI[1]=OFF 

………. 

The above sentence means that if DI[1] is ON, 

it will directly jump to LBL[1] and start 

execution. When the condition is false, it will 

execute sequentially from top to bottom. 
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J P[2] 

R[1]=R[1]+1 

GOTO LBL[1] 

LBL[2] 

 

19.3.2 IF…. , CALL 

Description： 

IF…. ,CALL subprogram，if the condition is true, execute the subprogram.PRG, then execute 

next programs sequentially. If the condition is false，execute the program of the next line after IF, 

ignoring the called subprogram. 

 

 

 

Note：Condition instructions also support compound condition such as  AND、OR、

Parentheses（） 

Instruction Condition instructions are used for motion logic control in the robot program. 

There are two types: IF condition, GOTO LBL[].  

IF condition, CALL "subprogram" 

IF <condition> , CALL Name of program.PRG 

                                                                                                   

Example： 

IF DI[1]=ON ,CALL TEST.PRG 

J JR[1] VEL=50 

DO[1]=OFF 

………. 

The above sentence means that if the DI[1] ON condition is true, the subprogram 

TEST.PRG will be called firstly. After the execution is completed, execute J JR[1] VEL 

=50, DO[1] =OFF and the following commands. Otherwise ignore the program 

TEST.PRG and execute J JR[1] VEL=50 DI[1]=OFF and the program blocks after…… 
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The sentence is: IF…. ,GOTO LBL[], if the condition is true, execute the GOTO code block; when 

the condition is false, execute the program of the next line after IF sequentially, ignoring the called 

subprogram.. 

Steps: 

1. Select the previous line of the IF instruction which needs to be added 

2. Select Instruction→Conditional instruction→IF 

3. Click the symbol button above the modification box to quickly add conditions; click options to 

add conditions, delete conditions, and modify conditions. When recording the sentence, the 

condition list will be connected in the order of addition. 

 

Figure 19-2 IF Instruction 

4. Click the Rise or Decline button in the operation column to move the position of the condition 

up and down. 

5. Click to increase group, a check box pops up, you can check the condition combination to fill 

the parentheses 

6. Check the check boxes of the conditions in the first to third columns, and then click to complete 

the grouping 

7. As shown in the figure below, select the first row. If click to ungroup, it can be restored to the 
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state in the figure above. 

 

Figure 19-3 IF Instruction-2 

8. Click the OK button in the operation column to add the IF instruction. 

Example 

LBL[1] 

IF (R[1]=10 AND R[2]=20 AND R[30]=30) OR DO[31]=ON , GOTO LBL[2] 

J  P[1]  VEL=50 

GOTO LBL[3] 

LBL[2] 

IF R[1]=2,CALL"TEST.PRG" 

J  P[2]  VEL=50 

LBL[3] 

GOTO LBL[1] 

Logic operation： 

The currently supported arithmetic operators are shown in the following table: 
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Operators  Operatonal rules Example（x=5，y=2） 

+ Left number plus the right 

number 

7 

— Left number menos the right 

number 

3 

* Left number multiply the right 

number 

10 

/ Left number divide the right 

number 

2.5 

MOD Left number divide the right 

number and take the 

remainder 

5 

2 

DIV The left and right division 

operations take integers 

The currently supported logical operators are shown in the following table: 

Operators Operation 

AND If one condition is false, all the conditions are false 

OR If one condition is true, all the conditions are true 

NOT  Take the opposite value of the logic 

The currently supported comparison operators are shown in the following table: 

Operators Operation 

= Equal to 

<> Not equal to 

< Less than 

> More than  

<= Less than or equal to 

>= More than or equal to 

MOD instruction：The division operation takes the remainder. The priority is the same as *, / 

DIV instruction：The division operation takes the integers. The priority is the same as *, / 
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NOT：Take the opposite value of the logic. It has the highest priority. 

19.3.3 SELECT Sentence 

Description 

Compare the value after the CASE with the value stored in the register after the SELECT. If they 

are equal, execute the instruction (GOTO or CALL) after this line of CASE, and the subsequent 

CASE and ELSE instructions associated with the SELECT will no longer be executed; if they are 

not equal, the corresponding instruction CALL XXX/GOTO LBL X in this line will not be executed 

and execute the CASE instruction or ELSE instruction in the next line. 

Example: 

SELECT R[0] 

CASE 1,GOTO LBL[1] 

CASE 2,GOTO LBL[2] 

CASE 3,CALL"RT.PRG Supplementary: when 3 is also 1, and R[0]=1, the previous 

LBL[1] will be executed for only one time 

ELSE,CALL"HS.PRG” // In actual use, this instruction does not necessarily exist 

GOTO LB[4] 

LBL[1] 

J P[1] 

GOTO LBL[4] 

LBL[2] 

J P[2] 

GOTO LBL[4] 

LBL[3] 

J P[3] 

LBL[4] 

The above sentences mean that the program is executed sequentially from top to bottom, matching 

R[0]. When R[0]=1, the program moves to P[1]. When R[0]=2, the program moves to P2. When 

R[0]=3, the program moves to point P3. When R[0] is not equal to 1/2/3, the program executes the 

contents of the subprogram HS.PRG of the ELSE instruction part (ELSE can also follow the 

GOTO ). Then proceed sequentially. 

 

SELECT, CASE, ELSE (not necessarily exist) need to be used together. If 

one misses, and program syntax errors will be reported. 
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19.4 Process instruction 

19.4.1 CALL Instruction 

Description： 

CALL instruction is used for calling subprogram, execute the content of subprogram. 

 

 

 

 

CALL Program’s name.PRG 

                                                                                                   

Example：These are two programs, main program MAIN.PRG, subprogram 

SON.PRG. 

‘MAIN.PRG(Main program) 

J JR[1] VEL=50 

J JR[2] VEL=50 

CALL SON.PRG  ‘Calling the subprogram 

‘SON.PRG（Subprogram） 

DO[1]=ON 

WAIT TIME 500 

DO[1]=OFF 

The above execution flow means: move the joints to JR[1] and JR[2] in turn, execute 

DO[1]=ON, wait for 500 milliseconds, DO[1]=OFF, turn off the pulse signal, and 

complete the program execution. 
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Remarks: program call supports multi-level nesting, 10 levels and above. 

Steps 

1. Select the previous line of the instruction line which needs to be inserted 

2. Select instruction→Flow instruction→CALL. 

3. Click to Select Subprogram button. 

4. Select the subroutine and confirm. 

5. Click the OK button in the operation column to add the CALL instruction. 

 

Figure 21-3 CALL Instruction 

19.4.2 GOTO LBL[] 

Description： 

GOTO instruction is mainly used to jump the program to the designated label position (LBL). To 

use the GOTO word, the LBL label must be defined in the program, and GOTO and LBL must be 

in the same block. 

 

 

 

 

 

 

 

Description 

GOTO instruction and LBL instruction need to be used together to realize the program’s jumping. 

GOTO will jump to the line designated by LBL.  

Steps 

1. Select the previous line of the instruction line which needs to be inserted. 

2. Select instruction→Process instruction→LBL，enter the Label Number 

LBL[Label’s name] 

GOTO LBL[Label’s name] 

                                                                              

LBL[1] 

J P[1] VEL=50 

J P[2] VEL=50          ‘Cyclic movement between two points 

GOTO LBEL[1] 
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Figure 19-4 Process Instruction-1 

3. Click “OK” in the operation column to insert the LBL instruction 

4.Select the instruction line to which needs to be skipped. 

5.Select instruction→Process instruction→GOTO，enter the Label number.

 

Figure 19-5 Process instruction-2 

6.Click “OK” to add the GOTO instruction. 

19.5 Loop instruction 

19.5.1 FOR Loop instruction 

The FOR loop instruction defines the initial value and final value of a variable, as well as the step 

value (that is, the size of each increment). It determines whether the loop variable value is less than 

or equal to the final value. If it is less than or equal to the final value, execute the loop, if it is false, 

then Exit the loop and form a loop at the end of the nearest END FOR. 

 

 

 

 

 

 

 

 

 

 

 

 

Use GOTO LBL[] 、LBL[] can make the program run cyclically.  

FOR R[1]=0 TO 3 BY 1 

’Program content 

END FOR 

                                                                              

Example： 

FOR R[1]=0 TO 3 BY 1 

J P[1] VEL=50 

J P[2] VEL=50        ‘Cyclic movement between two points, 

END FOR   
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Notes: as in the above program, the initial value of the variable R[1] of the loop R[1] is 0, the final 

value is 3, and the step value is 1. The value will be added by 1after each cycle. The first cycle 

assigns 0 to R[1]. The second cycle R[1]=R[1]+step value=1. The third cycle R[1]=2. The fourth 

cycle R[1]=3, which meets the final value, and the cycle ends, so there are four cycles in total. 

Steps: 

1. Select the previous line of the instruction line which needs to be inserted 

2. Select the instruction→Loop instruction→FOR 

3. Set the initial value and the final value in turn 

4. Click to set step button, set the step value, click OK 

 
Figure 21-6 FOR Loop instruction 

5. Click the "OK" button in the operation column to add the For condition 

6. Select the end position of the loop instruction line 

7. Select instruction→Loop instruction→END FOR 

8. Click OK in the operation column to add the FOR loop instruction. 

19.5.1.2 BREAK in the FOR Loop instruction 

BREAK instruction is used to interrupt the program loop, when this instruction is executed, exit and 

end the current loop. 

 

 

 

 

 

 

 

 

 

 

 

 

 

FOR R[1]=R[2] TO R[3] BY R[4] 

’Program Content 

BREAK 

END FOR 

                                                                              

Example： 

FOR R[1]=R[2] TO R[3] BY R[4] 

J P[1] VEL=50 

J P[2] VEL=50        ‘Cyclic movement between two points, 

BREAK               ‘When execute the break sentence, interrupt and exit the 

current loop 

END FOR 
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Note：as the program above, when execute the break sentence, regardless of whether it is equal to 

the final value, it should interrupt and exit the current loop and stop the loop  

19.5.2 WHILE Loop instruction 

The WHILE loop instruction judges whether the loop is over according to the conditional 

expression. When the condition is true, the loop continues, and when the condition is false, the loop 

exits.  

Note: The WHILIE loop instruction take the nearest END WHILE as the end to form a loop

Note: Condition instructions also support compound conditions AND, OR, parentheses () 

 

19.5.2.1 BREAK in cycle instruction WHILE 

The WHILE loop body can also be connected to BREAK. The usage is the same as the FOR 

loop instruction. When the BREAK instruction is executed, the current loop body is exited. Refer 

to the sample program of the FOR statement. 

 

Explanation: The cycle instructions include WHILE, END WHILE and FOR, END FOR 

instructions, which can be judged by logic conditions and execute block loops. 

 

Steps 

WHILE <condition> 

’Program Content 

END WHILE 

                                                                              

Example【1】： 

R[1]=0                    ’ Set the initial value of R[1] to 0 

WHILE R[1]<3 

J P[1] VEL=50 

J P[2] VEL=50        ‘Cyclic movement between two points 

R[1]=R[1]+1     Counting the number of cycles: conditional expression R[1], 

each cycle is 1, 2, 3, the fourth time R[1]=3, the condition of less than 3 is not met, so 

exit the cycle and there are 3 cycles totally. 

END WHILE 
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WHILE instruction 

1. Select the upper line of the command line to be inserted. 

2. Select Command→Cycle Command→WHILE→Option. 

3. Add condition → such as: "R[1]=0" → confirm. 

4. Click "OK" continuously to add WHILE R[1]=0. 

5. Select command→Cycle command→END WHILE→option. 

6. Click the "Confirm" button to add the WHILE cycle instruction to complete. 

 

Figure 21-7 WHILE instruction 

Program example 

WHILE R[1]=0 

J P[1]  VEL=50 

J P[2]  VEL=50 

＇BREAK       ＇Temporary note BREAK 

    END WHILE 
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Steps 

FOR instruction 

1. Select the upper line of the command line to be inserted. 

2. Select instruction→loop instruction→FOR. 

3. Set values such as: FOR R[1] = 0 TO 3 BY 1. 

4. Click the "OK" button. 

5. Select instruction→loop instruction→END FOR→option. 

6. Click the "Confirm" button to add the FOR cycle instruction to complete. 

Program example 

FOR R[1]= 0 TO 3 BY 1 

J P[1]  VEL=50 

J P[2]  VEL=50 

  END FOR 

19.6 IO instructions 

The IO instruction is divided into three parts: IO operation, Wait condition waiting, and WAIT 

TIME sleep instruction. 

 

 

 

 

 

 

 

 

 

 

 

The example above: when R[1]=0, P[1] and P[2] are running, and when R[1]

≠0, the motion program of the loop body is not executed; 

When R[1]=0, when the condition is met, when the BREAK comment is 

cancelled, P[1] and P[2] will exit the loop after executing only once. 

 

The above example: set the initial value of R[1] to 0, increase from 0 to 3, 

step value is 1, P[1] and P[2] cyclically move 4 times. 

IO instructions 

Operation IO 

Example: 

DO[1]=ON 

DO[1]=DI[2] 

Wait condition ’Wait for the condition to 

be met, then execute. 

Example: 

WAIT R[1]=1 

WAIT DI[1]=ON 

WAIT DI[1]=DO[1] 

  

WAIT TIME = Millisecond 

unit 

Example: 

WAIT TIME = 1000 
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19.6.1 WAIT 

Instructions: 

This instruction is used to wait for the value of a certain input, output state or R value to be 

equal to the set value. If the condition is not met, the program will always block in this line until the 

condition is met. 

 

 

 

 

 

 

 

 

 

 

 

Available conditions: 

WAIT DI[]=DI[]         WAIT DO[]=DO[]         WAIT R[]=DI[] 

WAIT DI[]<>DI[]        WAIT DO[]<>DO[]        WAIT R[]<>DI[] 

WAIT DI[]=DO[]        WAIT DO[]=DI[]          WAIT R[] = R[] 

WAIT DI[]<>DO[]       WAIT DI[]<>DI[]          WAIT R[] >R[] 

WATI DI[] = 1           WATI DO[] = 1           WATI R[] >= R[] 

WAIT DI[] = ON         WAIT DO[] = ON         WAIT R[] < R[] 

WAIT DI[] <> ON        WAIT DO[] <> ON        WAIT R[] <=R[] 

WAIT DI[] = OFF        WAIT DO[] = OFF        WAIT R[] <> R[] 

WAIT DI[] <>OFF        WAIT DO[] <>OFF       WAIT R[] = value 

WAIT DI[] = 1           WAIT DO[] = 1           WAIT R[] > value 

WAIT DI[] <> 1          WAIT DO[] <> 1          WAIT R[] >= value 

WAIT DI[] = R[]         WAIT DO[] = R[]          WAIT R[] < value 

WIAT DI[] <> R[]        WIAT DO[] <> R[]        WIAT R[] <= value 

                                                WAIT R[] <> value 

WAIT [condition]       

                                                                

WAIT DI[1]=ON 

J P[1] VEL=50 

J P[2] VEL=50                      

GOTO LBEL[1] 

As stated above, when DI[1] is not equal to ON, the program has been blocked 

on the WAIT DI[1]=ON program line. When DI[1]=ON, the program will execute 

down. 



 

 105 

19.6.2 WAIT TIME 

The function of the WAIT TIME instruction is to delay the execution of the program (task).The 

shortest delay time is 1, and the unit is [ms]. 

 

 

 

 

 

 

 

19.6.3 DO 

The DO instruction is used for the operation of output signals and the mapping between IOs. 

 

 

 

 

 

 

Note: There is no need to add a delay command between the motion command and the 

IO [as follows: the IO signal will be output only after the movement is completed at point P[1]] 

J P[1] 

D_OUT[1]=ON 

 

Explanation: IO instructions include DI, DO and WAIT instructions. The DO instruction can 

be used to assign ON or OFF the current IO, and can also be used to transfer values between DI and 

DO. The WAIT instruction is used to block waiting for a specified signal. The WAIT TIME 

instruction is used for sleep waiting, the unit is ms. 

Steps 

      DO instruction 

1. Select the upper line of the DO instruction line to be added. 

2. Select instruction→IO instruction→DO. 

3. Enter the IO serial number in the first input box. 

Example: 

J P[1] 

WAIT TIME 1000‘After moving to P1, after sleeping for 1 second, DI[1] will output the 

signal 

DI[1]=ON                        

J P[2] 

J P[3] 

Example: 

DO[1] = ON        ‘Output [1] is set to ON 

DO[1] = OFF       ‘Output [1] is set to OFF 

DO[1]=DO [2]      ‘Output [2] is assigned to output [1] 

DO[1]= DI[2]       ‘Input [2] is assigned to output [1] 
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4. Select the corresponding value or IO in the second selection box. If IO is selected, you 

need to enter the corresponding IO serial number in the corresponding input box. 

5. Click the "OK" button in the operation bar to finish adding IO commands. 

WAIT instruction 

1. Select the line above the WAIT command line to be added. 

2. Select any waiting signal in a selection box: DI, DO, R, TIME (in milliseconds), and enter 

the corresponding value. 

3. Click the "OK" button in the operation bar to complete the addition of the WAIT instruction. 

Program example 

WAIT R[1]=1 

J P[1]  VEL=100 

DO[1]=ON 

DO[2]=OFF 

WAIT TIME = 100 

J P[2]  VEL=100 

19.6.4 Timeout instruction 

Instructions: 

WAIT instruction usage scenarios can be divided into two situations. The first one is to wait 

for a certain input state (DI), output state (DO) or whether the value of R value is equal to the set 

value. If the condition is not met, the program will It has been blocked in this line until the condition 

is met to continue executing the following program content; the second type is to force to wait for 

a few milliseconds before continuing to execute the following program content. 

The WAIT timeout instruction is the instruction that acts in the first case, and is used in 

conjunction with the timeout setting, for example: 
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Note: When editing the WAIT instruction, after editing the WAIT conditions, if the LBL to be 

jumped after the editing timeout is selected as None, the timeout setting has no effect on the 

instruction. When the program is executed, if the conditions are not met, it will remain blocked. 

This line can only be released from this state by clicking "More→Release Waiting" in the lower 

menu bar. 

 

Figure 19-8 Timeout command 

WAIT DI[]/DO[]/R[]=value/DI[]/DO[]/ON/OFF TIMEOUT LBL 

                                                                                           

J JR[1] VEL=50 

WAIT DO[40]=ON TIMEOUT LBL 2 ‘WAIT timeout instruction 

J P[0] VEL=50 

LBL [2] 

J P[2] VEL=50 

In the above execution process, the joint moves to JR[1]. If DO[40]=ON within 

the timeout period, the instructions will be executed directly in sequence, and the joints 

will move to P[0] and P[2] in turn. DO[40]=OFF, the program is blocked in this line, if 

the waiting time exceeds the set timeout time, the pointer will jump to LBL[2], and 

continue to execute from this line, and the joint will move to point P[2] Without 

executing JP[0]. 
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19.6.5 PULSE Output Pulse Command 

Instructions: 

PULSE output pulse command, through which a certain output state (DO[X]) can be controlled 

to maintain a certain state for a period of time without affecting the program running beat. The 

corresponding output result can be updated synchronously in the teach pendant display. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

  

WAIT DO[X] TIME=value 

                                                                                    

Situation 1: 

J P[0] VEL=50 

WAIT DO[40] TIME=10000 

J P[1] VEL=50 

The above execution flow, the joint moves to point P[0], DO[40] is set to ON at 

this time, without waiting, the next line of motion instructions are executed normally, 

the joint moves to point P[1], the program execution is completed, and from DO[ 40] 

The output starts. After 10s, the output of DO[40] is turned OFF. 

Situation 2: 

If there are both DO and PULSE instructions in the same time period, unify the 

two and proceed according to the principle of change first. 

DO[40]=ON 

WAIT TIME=1000 

PULSE DO[40]=10000 

The above execution flow, DO[40] turns ON, DO[40] turns ON first in the 

PULSE instruction after 1s, and turns OFF after 10s. The output ON duration is 11s 

in total. 
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Note: If the program is unloaded when the output pulse is not over, the 

position will not be automatically reset to OFF. 

WAIT DO[] TIME=value 

                                                                                                   

Situation 3: 

When two pulse commands operate on the same IO at the same time in the same 

time period, they are superimposed in the time dimension according to the two pulse 

commands, and the pulse output is performed for the longer duration. 

 

 

 

 

 

 

 

Pulse command 

Pulse command 

Actual output 
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19.7 Program control instructions 

Instructions: 

This instruction is used for program execution control, including PAUSE pause, ABORT 

interrupt, END termination instruction. 

19.7.1 PAUSE instruction 

This instruction is used to suspend program execution. 

Steps 

1. Select the upper line of the command line to be inserted. 

2. Select instruction→program control instruction→PAUSE. 

3. Click the OK button in the operation bar to add the PAUSE command to complete. 

 

Figure 19-9 Pause instruction 

 

 

 

 

 

 

 

Remarks: As in the above program, the program moves to point P1 and then to point P2 in 

sequence. When the program executes to the PAUSE instruction, the program state changes from 

running to paused, and the current actual position is still at point P2. 

19.7.2 ABORT instruction 

This instruction is used to forcibly stop the program running and uninstall. 

Steps 

1. Select the upper line of the command line to be inserted. 

2. Select instruction→program control instruction→ABORT. 

3. Click the OK button in the operation bar to add the ABORT instruction to complete. 

Example: 

J P[1] 

J P[2]        

PAUSE     ‘When the program is executed to this line, the program status 

changes to pause. 

J P[3]        
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Figure 19-10 Abort instruction 

 

 

 

 

 

 

 

Remark: As in the above program, the program moves to point P1 and then to point P2 in 

sequence. When the program is executed to the ABORT instruction, the program state changes from 

running to waiting state, and the current actual position is at point P2. 

19.7.3 END instruction 

This instruction is used to end the program running. 

Steps 

1. Select the upper line of the command line to be inserted. 

2. Select instruction→program control instruction→END. 

3. Click the OK button in the operation bar to add the END instruction to complete. 

 

Figure 19-11 End instruction 

 

 

 

 

 

 

Note: As in the above program, the program moves to point P1 and then to point P2 in sequence. 

When the program is executed to the END instruction, the program state changes from running to 

ready state, the pointer returns to the first line, and the current actual position is at point P2. Press 

Example: 

J P[1] 

J P[2]        

ABORT     ‘The program executes to this line, stop and uninstall the 

program. 

J P[3]        

Example: 

J P[1] 

J P[2]        

END     ‘The program executes to this line, the program ends, and the 

program pointer returns to the first line. 

J P[3]        



 

 112 

the run button, the program moves to point P1 and then to point P2 in turn, the program state changes 

from running to ready state, and the pointer returns to the first line. 

 

Note: When a subprogram is called in the main program, and the 

subprogram contains END, the subprogram ends at this time and the main 

program continues to be executed. 

Program example 

‘Main program MAIN.PRG 

J  P[1]  

CALL LIB.PRG 

WAIT TIME = 100 

J  P[2]  VEL=100 

‘Subroutine LIB.PRG 

J JR[1] 

END  

J JR[2] 

Remarks: As in the above program, the main program MAIN.PRG calls the subprogram 

LIB.PRG, the execution flow is: the program moves to point P1 in turn, then calls the subprogram, 

moves to JR[1] point, when the program executes to the subprogram END instruction, End the 

subroutine, return to the main program, and then move to point P2, the program execution is 

complete. 

19.8 Other instructions 

19.8.1 THROW instruction 

Instructions: 

This instruction is used for user-defined part of alarms and prompts, alarm prompts the user or 

stop the robot program running. 

Fatal: Unrecoverable serious error, the robot stops moving, the motion buffer is cleared, the 

program enters an error state and the buffer is cleared, and it cannot be recovered (the program 

cannot be resumed). 

Error: A recoverable error. The robot stops moving and the program enters an error state, but 

the motion buffer is not cleared, and the operation can be resumed. 

Warning: Warning, the system is in a critical state or user operation may cause adverse 

consequences and other prompt messages, which will not cause the program or movement to stop. 
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Note: Reminder, general reminder information that gives users guidance. 

Info: Information, general system status information or user operation records not prompted 

by the user. 

 

Steps 

1. Select the upper line of the command line to be inserted. 

2. Select instruction→other instructions→THROW. 

3. Enter custom alarm information in the "THROW input box". 

4. Click the "Alarm Type" drop-down box option and select 

5. Click the OK button in the operation bar to add the THROW instruction to complete. 

 

 

Figure 19-12 THROW instruction 

19.8.2 RUN multi-threaded running instructions 

Instructions: 

This instruction enables the controller to run the logic PRG program in multiple threads in the 

background while running the main program. 

Steps 

1. Select the upper line of the command line to be inserted. 

2. Select instruction→other instructions→RUN. 

3. Click the "Select Subroutine" button and select the logic program. 

4. Click the "OK" button. 
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5. Click the OK button in the operation bar to add the RUN instruction to complete. 

 

The following case: 

The main program on the left: the main program with a group mask of 0. 

The logic program on the right: a multithreaded program with a group mask of *. 

Load the main program MAIN.PRG, the execution program is as follows, you can click 

the program interface display soft key in the status bar, and select the program to switch the 

program interface. (Soft keys can control all running programs at the same time. If you click the 

pause button, all running programs will be paused at the same time. Note: The physical buttons on 

the left side of the teach pendant are only for the program currently displayed by the controller). 

 

Figure 19-13 RUN instruction 

 

Click the program display box in the upper left corner to open the soft 

key. 

Sample program: 
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Figure 19-14 RUN instruction 

Remarks: As in the above program, the left side is the MAN.PRG main program, and the first 

line commands the RUN program (that is, the PLC.PRG multi-thread program on the right side. 

This program is always looping to check whether DO[50] is ON, if it is ON, an error will be reported 

Stop the program running, otherwise the MAIN main program will keep circulating the movement 

of P[0] and P[1]). 

RUN program operation is subject to the following conditions: 

①Enable conditions. When the program is running, disable the enable, the main program and 

the RUN program will end at the same time. When enabled, it can continue to resume operation. 

②Servo alarm. When the program is running, the servo alarms, the main program and the RUN 

program will end at the same time. When the alarm is removed, it can continue to resume operation. 

③The program error status will affect the operation of another group of programs. 

④External signal output is output according to the main program status. 

⑤External signal input: load the main program, but the RUN program will be loaded when the 

main program is loaded; START and PAUSE are only valid for the main program; unload and stop 

are valid for both programs. 

⑥When switching to the RUN program interface, it is controlled by the teach pendant buttons 

(pause, unload, back, start). 

⑦Controlled by program control soft keys. 

Resume operation after a pause in the middle. If the operation is suspended in the middle, the 
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main program and RUN program will stop running, and they can be resumed. 

Other considerations: 

①Only one set of logic PRG program and one set of robot motion control program are allowed 

to run at the same time. 

②During the execution of the RUN program, when a motion instruction is found in the 

program whose group mask is set to "*", the robot will stop running and report an error. 

③The program after RUN must be in a non-running state, and a program that is already in a 

running state cannot be run by the RUN command. Otherwise, it will alarm when the RUN 

instruction is executed. 

④RUN program alarm description: When the program is executed, an alarm message appears 

in the main program or RUN program, which is displayed on the teach pendant. For the alarm 

priority, there is no distinction between the main program and the RUN program. The same priority 

displays the last alarm message. 

 

Note: When the RUN logic program is edited and modified, it needs to 

be loaded in manual or automatic mode before the latest program will be 

sent to the system; among them, the ABORT, END, and PAUSE 

instructions in the multithreading only control the current program and 

do not affect the main program. 

19.8.3 SET_TR instruction 

Instructions: 

Specify the distance signal output command. The conventional robot arm will output the signal 

after reaching the point, but in the actual coating or welding process, the signal will be turned off/on 

after the movement reaches the point. (The process of the robot completing a trajectory is: static 

(starting point)- Acceleration-uniform speed-deceleration-stationary (the target point does not 

maintain a constant speed), but the glue gun cannot be opened after the robot is running stably, and 

the glue gun can not be turned off before the robot runs stably. This will cause uneven glue 

application and cause quality deviation. The instruction can specify the distance point for signal 

output. 

Starting point: Normally, it is the target point of the last motion instruction. When the 

movement is terminated, after restarting the movement, it is necessary to recalculate with the current 

position of the robot as the starting point. 

DS: The abbreviation of DISTANCE START, which refers to the distance from the starting 

point of the robot movement. 
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DE: The abbreviation of DISTANCE END, refers to the distance from the moving target point. 

DC: Abbreviation for DISTANCE COMPLETE, which refers to the percentage of the entire 

distance completed. 

 

Program example 

SET TR[1],DE=100, DO[ 9]=ON //Set trigger number 1, specify the distance of the end point 

target 100mm, output DO[9]=ON 

L P[1]  

L P[2],BIND_TR[0,1] //P2 point set trigger condition 0 or 1, can set single or multiple, separated by 

commas 

Note: As in the above program, the first line of the program is set to trigger 1-end point 100mm-

operation DO[9] (Note: when there is the same trigger number, it will be executed under the 

condition of the latest trigger number); the actual execution result of the program is: linear motion 

To P[1], then move straight from P[1] to P[2]. (Note: P2 point is set to trigger condition 0 or 1, and 

the first line of the program is set to trigger 1, because the internal periodical detection of robot TCP 

is 100mm away from P2 point, that is, at the radius boundary, the DO[9] signal output instruction 

is executed, as above Figure). 

The different distance types are as follows: 

Triggering 

conditions 

DS=xx DE=xx DC=xx 

Features The robot TCP outputs a 

signal when the distance 

from the starting point 

of the robot operation 

exceeds xx mm 

When the robot TCP is 

within xx mm from the 

target point of the robot, 

it outputs a signal 

When the robot TCP has 

run the motion instruction 

of the line, the robot TCP 

needs to move xx% of the 

entire distance, output a 

signal 

Triggering 

conditions 

The robot leaves the 

starting point, and the 

The robot starts to the 

target point, and the 

The robot starts to the 

target point, and the robot 
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distance (command) 

between the robot and 

the starting point is 

greater than xx mm 

distance (command) 

between the robot and the 

target point is less than xx 

mm 

TCP has traveled 

(instruction), the 

percentage of the total path 

length is greater than xx 

output 

signal 

When the robot meets the trigger condition, it outputs and closes the signal. 

Special 

cases 

①When the robot starts to move, it will output the corresponding signal when the 

trigger condition is met. 

②When there is CNT, the smooth transition does not pass through the target point, 

and it may appear that the distance to the target point has not met the trigger 

condition, so no signal output is performed. 

③When the program is suspended and resumed in the middle of the execution of 

the program line, it is necessary to judge the trigger condition with the current 

robot position as the starting point again 

④The designated distance signal output J joint command is invalid. 

⑤Supplement: During actual operation, the specified distance signal output is 

related to the operating speed of the robotic arm, and the signal output point will 

have a slight error, which can be adjusted by lowering the speed of the output point 

or adjusting the specified distance value. 

Steps 

1. Select the upper line of the command line to be inserted. 

2. Select instruction→other instructions→SET_TR. 

3. Click the "Trigger Number" input box and enter the trigger number. 

4. Click the drop-down box option on the left, and select the specified signal output type 

option. 

5. Click the "input distance" input box and enter the value. 

6. Click "IO Index Number" and enter the index number. 

7. Click the "Signal" drop-down box on the right to select ON/OFF. 

8. "OK" button to complete the instruction addition. (The binding trigger is edited and 

added at the motion instruction-additional instruction). 

 

Figure 19.15 Specified distance signal command-1 



 

 119 

 

Figure 19.16 Specified distance signal command-2 

19.8.4 Tool workpiece value modification instruction 

Instructions: 

This instruction can assign and modify the tool workpiece coordinate system value UTUF 

through the program. 

Example: 

LR[0]= UT[0]           //Assign the coordinate value of tool number 0 to LR[0] 

LR[1]= UF[15]          //Assign the coordinate value of workpiece number 15 to LR[0] 

LR[0]=LR[0]+LR[1]     //LR[0] and LR[1] are added and the result is assigned to LR[0] 

LR[1][2]=UF[15][2]+10  //Add 5 to the Z axis value of workpiece number 15 and assign the 

result to the Z axis of LR[1]. 

UFRAME_NUM = 15 

UTOOL_NUM = 0 

SET_TOOL 0 LR[0]    

SET_FRAME 15 LR[1] 

L P[1] 

L P[2] 

Remarks: As in the above program, the first 4 lines acquire tool and workpiece values and 

assign and modify them, update and call the corresponding coordinate system commands, modify 

the coordinate value of tool number 0 to LR[0] and the coordinate value of workpiece number 15 to 

LR[ 1], the final P[1] point and P[2] are executed according to the modified tool workpiece 

value LR[0] and LR[1]. 

Steps 

1. Select the upper line of the command line to be inserted. 
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2. Select instruction→other instructions→SET_TOOL/SET_FRAME. 

3. Click the "SET_TOOL/FRAME" input box and enter the tool or workpiece number. 

4. Click the "LR" input box again and enter the LR index number. 

5. Click the "OK" button to complete the instruction addition. 

 

 

The range of X in UT[X]/UF[X] is 0-15, corresponding to tool 

number/workpiece number respectively. If it is not in this range, an error 

will be reported when running to this line: invalid tool number/workpiece 

number. 

19.9 Offset instruction 

19.9.1 Absolute motion command 

Explanation: Absolute motion is compensated in the fixed point position information of the 

robot. According to actual usage requirements, it can be divided into position compensation and 

tool compensation. Among them, position compensation is performed in the user coordinate system, 

and tool compensation is performed in the tool coordinate system. 

19.9.1.1 OFFSET position compensation command 

Explanation: Position compensation commands are divided into conditional position 

compensation and direct compensation. 

 

 

 

 

 

 

 

Remarks: As in the above program, the program assigns JR[2] to the global position offset, and 

moves to JR[0] point in turn (without OFFSET, no offset). When the last line is executed, it will 

move a new offset Shift the compensation position, namely JR[3]=JR[1]+JR[2] (with OFFSET, and 

the value of OFFSET CONDITION is JR[2]). 

Example of conditional compensation instruction: 

OFFSET CONDITION=JR[2]   ‘Define the global position compensation 

amount. 

J JR[0]           ‘Correctly move to JR[0] coordinate position. 

J JR[1]  ,OFFSET ‘JR[1]+JR[2] moves to a recalculated position. 
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Remark: As in the above procedure, move to JR[0] point in sequence (without OFFSET, no 

offset), when the last line is executed, it will move to a re-offset compensation position, that is 

JR[3]=JR[1] +JR[2] (With OFFSET JR[2], the direct offset is JR[2]). 

 

Note: ① Motion command J JR[1] OFFSET If the OFFSET 

CONDITION command is not defined before, it will report that the 

OFFSET value is not set during operation; ②When executing J JR[1] 

OFFSET or J JR[1] OFFSET JR[2], if executed Before this instruction, 

if JR[2] point information is modified midway, the offset will also change 

synchronously. ③The coordinate expression of the compensation point 

position can be inconsistent with the target point (for example, the target 

point uses the joint coordinate system, and the compensation point 

position uses the Cartesian coordinate system). ④ When the arc 

command is compensated, only the end point is compensated, and the arc 

transition point is not. make up. 

 

Steps 

1. Select the previous line of the instruction line to be inserted or. 

2. Select instruction → motion instruction → additional assignment to enter the 

additional instruction editing interface. 

3. Check the position compensation check box and set the position compensation 

options. 

4. Click the "OK" button to set the motion instruction point, and then click the "OK" 

button in the operation bar to complete the addition of the position compensation 

instruction. 

 

 

 

 

Examples of direct position compensation instructions: 

J JR[0]           ‘Correctly move to JR[0] coordinate position. 

J JR[1]  ,OFFSET JR[2]  ‘JR[1]+JR[2] moves to a recalculated position. 
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Figure 19-17 Position compensation command 

19.9.1.2 TOOL_OFFSET tool compensation instruction 

Description: The robot moves to the compensation position of the target point in the tool 

coordinate system. The specific performance is that the corresponding XYZ value is first translated 

in the direction of the tool coordinate system, and then the current position is first rotated around 

the tool Z axis. Rotate around the Y axis of the tool, and finally rotate around the X axis of the tool. 

The actual performance is coherent, and the corresponding attitude angle remains unchanged when 

the tool is translated in the direction of the tool coordinate system. When changing the direction 

around the tool coordinate system, the position remains unchanged. There are two ways to display 

tool compensation commands on the teach pendant. One is expressed by tool compensation 

conditional instructions, and the other is expressed by direct tool compensation instructions. 

 

 

 

 

 

Remark: As in the above program, the program assigns JR[2] to the global position offset, and 

moves to JR[0] point (without offset) in sequence. When the execution reaches the last line, the 

robot moves directly from JR[0] To (JR[1]+LR[2]) position. 

  

Examples of tool condition compensation instructions: 

TOOL_OFFSET CONDITION=LR[2]   ‘Define the global position 

compensation amount. 

J JR[0]                        ‘No offset is set, move directly to JR[0]. 

J JR[1]    ,TOOL_OFFSET      ‘Move to (JR[1]+LR[2]) position. 
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Remark: As in the above program, move to JR[0] point in sequence (without setting offset). 

When the last line is executed, it will move to a position for re-tool position compensation, and the 

robot will move directly from JR[0] to (JR[ 1]+LR[2]) position. 

 

Note: ①Motion instruction J JR[1] TOOL_OFFSET, if TOOL_OFFSET 

CONDITION instruction is not defined before, it will report that 

OFFSET value is not set during operation; 

②When J JR[1] TOOL_OFFSET or J JR[1] TOOL_OFFSET LR[2] is 

executed, if the TOOL_OFFSET offset JR[2] point information is 

modified midway before the instruction is executed, the offset will also 

change synchronously. 

③The coordinate expression of the compensation point position can be 

inconsistent with the target point (for example, the target point uses the 

joint coordinate system, and the compensation point position uses the 

Cartesian coordinate system). 

④ When the arc command is compensated, only the end point is 

compensated, and the arc transition point is not compensated. ⑤Only 

LR variable can be used for tool compensation. 

Steps 

1. Select the previous line of the instruction line to be inserted or. 

2. Select instruction → motion instruction → additional assignment to enter the 

additional instruction editing interface. 

3. Check the tool compensation check box to set the position compensation options. 

4. Click the "OK" button to set the motion instruction point, and then click the "OK" 

button in the operation bar to complete the addition of the tool position compensation 

instruction. 

Examples of direct tool compensation instructions: 

J JR[0]           ‘Correctly move to JR[0] coordinate position. 

J JR[1]  ,TOOL_OFFSET LR[2]  ‘Move to (JR[1]+LR[2]) position. 
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Figure 19-18 Tool compensation command 

Add global offset 

Steps 

1. Select the upper line of the command line to be inserted. 

2. Select Instruction → Assignment Instruction, click the leftmost input box, select the 

second drop-down box [Global Variables] option, slide to select the 

OFFSET_CONDITION or TOOL_OFFSET_CONDITION option. 

3. Click the input box on the right, select the first drop-down box [register], select JR[] or 

LR[], and enter the index number. 

4. Click the OK button in the operation bar to complete adding the global offset. 

 

Figure 19-19 Global offset instruction 

19.9.2 INC incremental instruction 

Explanation: Relative movement is also called incremental movement. The instruction is INC. 

It moves on the basis of the current position of the robot. It means: use the recorded point register 

value as the relative movement of the current robot to move the robot. J P[] ,INC is a separate motion 

program line, where P[] is the relative motion point, relative to the distance from the current position 

of the robot, it can be the joint coordinate value or the Cartesian coordinate value. 
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Remarks: The above procedure, such as:  

JR[0]={0,-90,180,0,90,0},JR[1]={10,10,10,10,10,10}, JR[2]={-5,-5,-5,-5,-5,-5}, the 

execution process is the joint movement to JR[0] point, the second line J JR[1] will be based on the 

previous point Do a relative movement, it will move (JR[0]+JR[1]), the third line, move to 

(JR[0]+JR[1]+JR[2]). 

The coordinates of the three points in sequence are: 

J JR[0]={0,-90,180,0,90,0}, 

J JR[1]=JR[0]+JR[1]={0,-90,180,0,90,0}+{10,10,10,10,10,10}={10,-80,190,10,100,10},  

J JR[2]=JR[1]+JR[2]=JR[0]+JR[1]+JR[2]= {0,-90,180,0,90,0}+{10,10,10,10,10,10}+ 

{-5,-5,-5,-5,-5,-5}={5,-85,185,5,95,5} 

Steps 

1. Select the previous line of the instruction line to be inserted or. 

2. Select instruction→motion instruction→additional assignment to enter the additional 

instruction editing interface. 

3. Check the incremental check box. 

4. Click the "OK" button to set the motion instruction point, and then click the "OK" 

button in the operation bar, the incremental motion instruction is added. 

 

Figure 19-20 Incremental instruction 

Example of relative motion INC instruction: 

J JR[0]        ‘Move to JR[0] 

J JR[1] INC    ‘Do incremental movement based on the previous point, 

move to JR[0]+JR[1] 

J JR[2] INC    ‘Incremental movement based on the last point, movement 

to (JR[0]+JR[1]+JR[2]) 
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19.10 Get coordinates command 

Explanation: In the program, the current position of the robot is obtained through the 

JPOS/LPOS instruction, which can be transferred to the corresponding position register JR/LR. 

JPOS records the current joint coordinate position of the robot; LPOS records the Cartesian 

coordinate position of the robot in the current tool workpiece coordinate system. 

 【Remarks】When using JPOS/LPOS instructions, JPOS/LPOS instructions can only appear on 

the right side of the assignment to the equation, and JPOS can only transfer values to JR registers, 

and LPOS can only transfer values to LR registers. Support the assignment operation of register 

instructions. 

19.11 FINE positioning instructions 

Instructions: 

The FINE positioning instruction is a smooth transition CNT to increase the FINE positioning 

attribute, so that the robot can accurately move to the target position, so as to optimize the accuracy 

of the robot's movement to the target point. Note: Smooth transition (that is, CNT=value) and 

CNT=FINE cannot be applied to the same motion instruction at the same time. 

 

 

 

 

19.12 Assignment instruction 

Explanation: The assignment instruction is divided into three parts: register operation, 

coordinate system call and global parameter. 

  

L P[0] 

L P[1] CNT=FINE 

L P[2] 

The above execution process, first move to P[0] in a straight line, then move to the point 

P[1] accurately, and then move to the point P[2] in a straight line 

 

 

 

 



 

 127 

 

 

 

 

 

 

 

 

 

 

 

 

 

19.12.1 Register instruction 

Instructions: 

The Huashu III system predefines several groups of different types of registers for users to use. 

Contains floating-point type R registers, joint coordinate type JR registers, Cartesian type LR 

registers, of which 300 R registers are available for users, and there are 300 JR and LR registers. 

Generally, the user assigns the preset value to the register corresponding to the index number, such 

as: R[0]=1, JR[0]=JR[1], LR[0]=LR[1], the register can be directly Used in the program. 

Register instructions include R[], JR[], LR[], JR[][], LR[][], P[], P[][]. 

  

Assignment instruction 

Register 

R[1]=0 

JR[1]=JR[0] 

LR[1]= LR[0] 

JR[1]= P[1] 

JR[1][0]=JR[1][1] 

LR[1][R[1]]=R[2]   etc. 

Coordinate System 

UTOOL_NUM=0 

UFRAME_NUM=0 

Motion-global 

variables 

CNT = 100 

L_VEL =50 

L_ACC =50 

L_DEC = 50 

L_VROT = 50 

J… 

C… etc. 
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Description Register instructions are used for register assignment changes, etc., including 

floating-point R registers, joints as coordinate type JR registers, Cartesian type LR registers, of 

which 300 R registers are available for user use, JR and LR registers have 300 One. Generally, the 

user assigns the preset value to the register corresponding to the index number, such as: R[0]=1, 

JR[0]=JR[1], LR[0]=LR[1], the register can be directly Used in the program. 

Register instructions include R[], JR[], LR[], JR[][], LR[][], P[], P[][]. 

Steps 

1. Select the previous line of the register instruction line to be added. 

2. Select instruction → Assignment instruction. 

Example: 

R[1] = 1 

R[1] = R[2] 

R[1] =R[1]+1 

R[1] = DI[1] 

R[1] =DO[1] 

R[1] = JR[0][0]+LR[0][1]*R[2]-(R[3]/2+R[4])  

JR[1]=JR[2] 

JR[1]=JR[2]+JR[3] 

JR[1]=(JR[2]*JR[3])+(JR[4]/JR[5]-JR[6]) 

JR[R[1]]=P[1] 

JR[1][0]=JR[3][0] 

JR[1][8]=R[1] 

JR[1][0]=P[1][0] 

JR[1][1]=JR[1][R[1]]*2 

JR[1][1]= JR[1][1]*R[2] 

JR[R[1]][R[2]]=JR[1][0]-R[1] 

JR[(R[23]+JR[1][1])-(JR[1][8]/P[1][0])*2-21] = (JR[1]-

JR[2])+JR[R[1]]*P[R[1]]/(R[1]+1) 

As mentioned above, it is used for register compound operation. Same 

for LR and P. 

Note: LR[1]=LR[2]+LR[3], at this time LR[1] takes the form of 

LR[2]. 
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3. In the first input box, select the register type from the "register" drop-down box. 

4. Enter the register index number in the input box. 

5. Repeat steps 3~4 in the second input box. 

6. Click the "OK" button in the operation bar to complete the assignment-adding of 

register instructions. 

 

 

 

 

 

 

 

 

 

 

【Remarks】 

The JR\LR register supports obtaining the current robot position to the position register and 

modifying the value of the current position register during program editing. The specific operation 

method is as follows (take motion instruction J JR[0] as an example): 

Select the motion instruction J JR[0] and click "Record joint" to open the JR[0] register editing 

interface. After modifying the coordinate value, click "OK" to save the currently modified 

coordinate value to JR[0] register. It should be noted that when the JR register is used in the motion 

instruction, only the joint position can be recorded, and when the LR register is used in the motion 

instruction, only the Cartesian position can be recorded. 

19.12.2 Coordinate system command 

Instructions: 

This instruction is used to call the tool and workpiece number by the program (Note: the point 

is recorded in the program. If the tool workpiece is used, the tool workpiece coordinate system needs 

to be added to the program). , The defined coordinate system number can be selected in the program, 

and the coordinate system can be switched in the program. The tool and workpiece numbers are 

0~15, and the default coordinate system is -1. 

  

Then JR[0][1] refers to the 

second axis of JR register index 

[0], which is 90 

Assuming JR[0]={0,-90,180,0,90,0} 
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Remarks: The available tool workpiece numbers are 0~15, and -1 is the default coordinate 

system. 

Note: If the point recorded by the tool or workpiece is called, the corresponding coordinate 

system instruction path movement must be added in the program to be correct. 

19.12.3 Global variable instruction 

Explanation: The global variable instruction is used to define the global parameters of the 

program, and it takes effect in the entire program, except for those with its own parameters. 

 

The range of motion parameters is as follows: 

The difference between global parameters and local parameters is as follows: 

  

Example: 

UFRAME_NUM = 0 

UTOOL_NUM = 0     

L P[1] VEL=50       

L P[2] VEL=50       

UFRAME_NUM = -1         , Do not call tool artifacts at the 

following points 

UTOOL_NUM = -1   

J P[3] VEL=50 

J P[4] VEL=50 

In the above expression, P[1] and P[2] call tool, workpiece number 0, 

P[3], P[4] point does not call tool and workpiece, the value needs to be set to 

-1, the coordinate system command is to Work under. 
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Steps 

1. Select the upper line of the register instruction line to be added. 

2. Select instruction → assignment instruction. 

3. In the first input box, select the type from the "Global Variable" drop-down box. 

4. Enter the value in the second input box. 

5. Click the "OK" button in the operation bar to complete the assignment-adding of the 

global variable instruction. 

Program example 

LBL[1] 

UFRAME_NUM=1 

UTOOL_NUM=1 

L_VEL = 500 

L_ACC = 80 

LBL [888] 

J  P[1]            

J  P[2]    ‘Is the default 

motion parameter 

J  P[3]   

J  P[4] 

GOTO LBL[888] 

LBL[888] 

CNT =1 

J_VEL = 100 

J_ACC = 100    

J_DEC = 100 ‘Global motion parameters, work downwards, P[1~4] 

use the above motion parameters 

J  P[1]            

J  P[2] 

J  P[3]   

J  P[4] 

GOTO LBL[888] 

LBL[888] 

CNT =1 

J_VEL = 100 

J_ACC = 100    

J_DEC = 100   ‘Global motion parameters, work downwards, P[1, 3] use the above motion parameters 

J  P[1]            

J  P[2]  VEL = 50  ACC = 50  DEC = 50 CNT = 0 ‘P[2] Use own motion parameters 

J  P[3]  VEL = 50 ’P[3] uses its own VEL parameters, because other parameters have not been set, so the 

global ACC and DEC above are still used 

GOTO LBL[888] 
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L_DEC = 80 

L  P[1]    ＇Call tool number 1 and workpiece number 1 and set global linear motion 

parameters. 

L  P[2]  VEL = 200  ACC = 60  DEC = 60 ＇Use your own linear speed, acceleration 

ratio, deceleration ratio. 

UFRAME_NUM = -1 

UTOOL_NUM = -1 

L  P[1]   ＇Call the default coordinate system tool number -1 and workpiece number -

1 and set the global linear motion parameters. 

L  P[2]   ＇Call the default coordinate system tool number -1 and workpiece number -

1 and set global linear motion parameters. 

The motion parameters are as follows: 

The global parameter command is used to define the global parameters of the program, which 

takes effect in the entire program, except for those with parameters. 

For usage refer to [Motion Parameters] section. 

 

 

 

 

 

 

 

19.12.3.1 Arc transition CNT 

Explanation: CNT mode can be used in joint interpolation and Cartesian interpolation mixed 

motion. This parameter defines the starting position of arc transition, and its value is a percentage. 

CNT = 0~100                   ‘Smooth transition is 0, default is not smooth. 

CNT_TYPE=0/1/2/17            ‘Smoothing type, default is 0. 

J_VEL = 1~100                  ‘Joint speed, default 50. 

J_ACC = 1~100                  ‘Joint acceleration, default 50. 

J_DEC = 1~100                  ‘Joint reduction ratio, default 50. 

L_VEL = 1~1000                 ‘Linear speed, default 2400, different models vary. 

L_ACC = 1~100                  ‘Linear acceleration ratio, default 50. 

L_DEC = 1~100                  ‘Linear reduction ratio, default 50. 

L_VROT = 1~500       ‘Straight line attitude speed, default 420, different models have different. 

C_VEL = 1~1000                 ‘Arc speed, default 2400, different models vary. 

C_DEC = 1~100                  ‘Arc reduction ratio, default 50. 

C_ACC = 1~100                  ‘Arc acceleration ratio, default 50. 

C_VROT = 1~500              ‘Arc attitude speed, default 420, different models have different. 

Remarks: All units except L_VEL, C_VEL, L_VROT, C_VROT, CNT_TYPE are 100%. 
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The path is A->B->C, and the arc transition function is used at point B, then the blending 

coefficient value defines the position of the starting point of the arc transition, point D: AD=mixing 

coefficient*AB/100. 

When this parameter is set to 100, it means that the arc transition starts at point A and ends at 

point C, and the entire new path is completely different from the original path. But when this 

parameter is set to 0, it means that the arc transition function is not used. 

Example: 

L P[1]               ‘Point A. 

L P[2]  CNT=40    ‘Point B starts at 40% of the AB line segment and transitions 

smoothly to point C (ie point D, BD=40/AB). 

L P[3]               ‘Point C. 

 

Special instructions: as shown 



 

 134 

 

 

【Signal output and smooth transition point】 【WAIT waiting conditions and smooth 

transition】 

 

 

 

 

 

 

 

19.12.3.2 Smoothing type CNT_TYPE 

Explain: The smoothing type CNT_TYPE extends two different smoothing types. Different 

values correspond to different types. CNT_TYPE=0 is normal smoothing and 1/17 is used for small 

line segments (both are speed-type smoothing. Note that the motion parameters set by 

CNT_TYPE=17 are: Actual delivery speed), but at this time the unit of L_Acc becomes degree/s^2, 

not a percentage), which is used for gluing, grinding, and small line applications. 

19.12.4 Trim command 

Explanation: The VORD instruction uses the program to adjust the program adjustment value 

of the robot. It can be assigned as a constant or R[] register, and the value range is 1-100. When the 

program executes to the VORD instruction, no matter which mode the robot is currently in, the 

 

Smoothing type commands take effect downward; 

The default value can be obtained through R[0]=L_VEL, etc. It is 

recommended to use the default value to adjust from the low speed until 

the requirement is met. 

L P[1] 

L P[2] CNT=50 

DO[1] = ON   ‘At this time, the signal is 

output at the transition point D. 

J P[3]            

 

L P[1] 

L P[2] CNT=50 

WAIT DO[1] = ON   ‘At this time, the signal is 

output at the transition point D. 

J P[3]  ‘Note: If the WAIT condition is not met, it 

will stop at P[2] and wait for the condition to be 

met. There is no smooth action at this time. 
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program adjustment value is changed to the data executed by the current VORD instruction, and the 

VORD instruction takes effect downward and can be assigned to the R register. The usage method 

is: R[1]=VORD Means to obtain the current robot's program adjustment value R[1]. 

Steps 

1. Select the previous line of the instruction line to be added. 

2. Select instruction → assignment instruction. 

3. In the first input box on the left, select the type from the "Global Variables" drop-down 

box. 

4. Select the VORD option. 

5. Click the input box on the right and enter the value. 

6. Click the "OK" button to complete the modification instruction addition. 

 

Figure 19-21 Modification command 

19.12.5 Timing instruction 

Explanation: The TIME instruction can calculate the beat or the program running time, the unit 

is ms. 

Example 

R[1]=TIME 

J P[1] 

      J P[2] 

      R[1]=TIME-R[1]   

 

Remark: As in the above program, the first line assigns the system time to R[1], runs P1 and 

P2 in turn, and the last line calculates the difference between the current time and the previous save 

time and saves it to the R[1] register. You can know the running time from P[1] to P[2] by looking 

at the value of R[1] register. 

Steps 

1. Select the upper line of the command line to be inserted. 

2. Select instruction→assignment instruction→register. 

3. Slide the drop-down box option and select R[] and enter the index number. 
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4. Click and position the cursor to the right input box. 

5. Click the "Global Variables" drop-down box option. 

6. Slide the options to find the "TIME" option and click to select. 

7. Click the "OK" button to complete the adding instruction. 

19.13 Manual instruction 

Description: Used to manually enter the command line. 

 

Figure 19.13 Manual command 

Steps 

1. Select the previous line where the manual instruction needs to be inserted. 

2. Enter the instruction. 

3. Click the OK button in the operation bar to finish adding instructions. 


